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Welcome

Congratulations on your purchase of Kodak® Prinergy® Evo™ software! Your 
system will be shipped to you soon.

We encourage each member of your team to review this learning package before 
your system is installed.

Your training consists of web-based training and hands-on activities with sample 
files. You can work alone and at your own pace.

You can also use these tools to coach someone else to learn Prinergy Evo.

All the tools are available on the Kodak Prinergy Evo 4 Training DVD and from 
https://ecentral.graphics.kodak.com.

Target Audience
• Prepress operator

• Proof or plate operator

• Prepress system administrator

Optional:

• Prepress manager

• Customer service representative

Past Learning Requirements
You are advised to have:

• Basic prepress knowledge

• Experience using prepress software applications—for example, 
QuarkXPress® or Adobe InDesign® software

• Apple® Mac OS® X operating system software system knowledge

• Microsoft® Windows® 2000 or Windows Server® 2003 operating system 
knowledge
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Getting Ready

Prepare Your System
Prepare to use this learning package by completing the following steps:

1. Install Adobe Flash® Player 7.0 or higher.

2. Install Acrobat Reader.

3. Install a supported web browser. Internet Explorer 6.0 or higher is 
recommended.

4. Set your monitor display to 1024 x 768 pixels.

Learning Tools
The Kodak Prinergy Evo 4 Training DVD contains the tools you need to learn 
Prinergy Evo:

• Prinergy Evo Activities Guide (this guide):

– Learning Path

– Task-Oriented Activities

• Learning Prinergy Evo Web-based Training

We strongly recommend that you use these tools in the following order:

1.  The Prinergy Evo Learning Path (in this guide)

Use this section to choose the training tools and specific activities that are 
relevant to your job. This way you can complete the training in the shortest 
possible time.

Your learning path also depends on the Prinergy Evo configuration purchased by 
your company.

For more information, refer to page 4 in this guide.

2.  Learning Prinergy Evo Web-based Training 

The web-based training provides an interactive introduction to Prinergy Evo. You 
will learn about the Prinergy Evo workflow, the user interface, and key workflow 
steps and concepts.

You will save time and be more effective with Prinergy Evo if you complete the 
web-based training before your system is installed.

Note: Note both of these players are free and can be downloaded from Adobe at 
http://www.adobe.com.



Prinergy Evo    3

You can run the web-based training directly from the main menu on the Kodak 
Prinergy Evo 4 Training DVD.

3.  Prinergy Evo Task-Oriented Activities (in this guide)

This section contains several groups of practical hands-on activities that you can 
use to learn Prinergy Evo quickly. The sample files for each activity are on the 
Kodak Prinergy Evo 4 Training DVD.

• Preparing for Task-Oriented Activities

Explains how to set up the sample activity files on your Prinergy Evo server.

• Activities 1 to 13

Learn important functions such as refining an input file using a template 
palette and creating an output workflow.

• Activities 14 to 25

Gain additional knowledge and skills related to installation, configuration, 
prepress production, troubleshooting, and system administration.

• Activities 26 to 30

Learn how to configure preflight profiles, create a layout using an output PDF 
process template, and automatically create impositions.

• Activities 31 to 36

Take advantage of workflow templates and dynamic settings to further 
automate your prepress workflow and increase production.

• Activities 37 to 41

Learn how to work with transparency in files, how to import and export 
templates, how to apply Plate and Print Calibration curves, and how to add 
variable text sluglines to output.

For more information refer to page 9 in this guide.

Identify Your Job Role 
Choose your job role and follow it throughout this guide to create your learning 
path.

• Prepress manager

• Prepress operator

• Proof or plate operator

• Prepress system administrator

• Customer service representative
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Learning Path
Choose the training tools and specific activities that are relevant to your job.

1. Understand Prinergy Evo

2. Apply workflow concepts and navigate Prinergy Evo

Job Role Topic Use this Learning Tool

Everyone Prinergy Evo features, 
concepts, supported input 
file formats

• Web-based training

• Prinergy Evo Activities 
Guide

Job Role Topic Use This Learning Tool

Everyone Process templates

Hot folders

Template Palette, Browser

Virtual printers

Process Viewer

• Web-based training

• Prinergy Evo Activities 
Guide

• Prinergy Evo Client 
Help
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3. Process input files

Job Role Topic Use This Learning Tool

Prepress operator

Prepress manager

Prinergy Evo features, 
concepts

• Web-based training

• Prinergy Evo Client  
Help

Refine PDF and Adobe 
PostScript® input files

Activity 3, 4, 7

Refine with spot color 
handling

Activity 5

Refine an imposed 
PostsScript flat with OPI

Activity 12

Refine and trap input files Activity 13

Edit PDF page trim and bleed 
settings with Kodak 
Prinergy® Geometry Editor 
software

Activity 24

Apply PDF Preflight settings Activity 26

Automatically create 
impositions

Activity 28

Create a workflow template Activity 31

Apply dynamic settings to 
refine

Activity 32

Use dynamic settings to 
build a signature list

Activity 33

Transparency handling Activity 37, 38
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4. Output to proof and plate 

Job Role Topic Use This Learning Tool

Prepress operator

Proof operator

Plate operator

Prepress manager

Prinergy Evo features, 
concepts

• Web-based training

• Prinergy Evo Client  
Help

Output a PDF file to proof or 
plate

Activity 1, 2, 6 

Output a PDF page-based 
imposition to proof or plate

Activity 9, 21

Monitor output processes in 
Process Viewer

Activity 1, 2, 6

Output Signature Booklet 
imposition proof

Activity 29

Create a workflow template Activity 31

Apply dynamic settings to 
output from PDF and output 
from imposition

Activity 32

Use dynamic settings to 
output from imposition

Activity 33

Ouput a single PostScript flat Activity 34

Remake a plate using Plate 
ID

Activity 35

Use TIFF Downloader to 
output 1-bit TIFF files

Activity 36

Apply Plate and Print 
Calibration Curves

Activity 40

Add variable text sluglines to 
output

Activity 41
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5. Customize the workflow

Job Role Topic Use This Learning Tool

Prepress manager

Prepress system 
administrator

Prinergy Evo features, concepts • Prinergy Evo Client  
Help

• Prinergy Evo 
Administrator  
Help

Create a process template Activity 6, 7 

Configure a template palette Activity 8

Configure a hot folder Activity 2, 4

Configure an automatic refine and 
output workflow using hot folders

Activity 10

Configure an automatic refine and 
output workflow using a template 
palette

Activity 11

Configure a virtual printer Activity 15

Create and add colors to a spot 
color library

Activity 23

Create relative file paths to 
organize files within job folders

Activity 25

Create a workflow template Activity 31

Apply dynamic settings to refine, 
output from PDF, output from 
imposition

Activity 32

Use dynamic settings to build a 
signature list and output from 
imposition

Activity 33

Remake a plate using Plate ID Activity 35

Use TIFF Downloader to output 1-
bit TIFF files

Activity 36

Import and Export Process and 
Workflow Templates

Activity 39

Apply Plate and Print Calibration 
Curves

Activity 40

Add variable text slugline to 
output

Activity 41
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6. Administer the Prinergy Evo system 

7. Help someone learn the Prinergy Evo workflow

Sometimes a coach can help the learning process.

Job Role Topic Use This Learning Tool

Prepress manager

Prepress system 
administrator

Prinergy Evo features, 
concepts

• Prinergy Evo System 
Administration Guide 

• Prinergy Evo Client  
Help

• Prinergy Evo 
Administrator Help

Restart the system Activity 17

Resolve problems Activity 18, 19

Install Prinergy Evo software 
updates

Activity 14

Import and export process 
and workflow templates

Activity 39

Job Role As a Coach, You Will Use This Learning Tool

A coach might be a: 

• Prepress operator

• Prepress 
manager

• Prepress system 
administrator

• Develop your own 
expertise with Prinergy 
Evo 

• Plan the learning path 
with your learner, based 
on their job role

• Select the appropriate 
learning tools for your 
learner

• Check the learner’s 
progress. Ask and 
answer questions.

• Web-based training

• Activities 1 to 45
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Task-Oriented Activities

Introduction

Overview

Each activity is a collection of related concepts and hands-on tasks that provide 
you with practical experience with Prinergy Evo.

Sample files are supplied for each activity. Be sure to read the section Preparing for 
Task-Oriented Activities on page 11

You can use the Learning Path section on page 4 to select the activities that are 
related to your job. You may disregard some activities if you do not use particular 
features of the system.

Best Practice

• Read the activities and select the ones you need

• Allow between four and six hours to complete your activities

• Schedule time to complete the activities, for example, in one session or in 
blocks of time

• Tell your co-workers you are in training

• Find a quiet place to do your training

• Refer to the support documentation, as required

• Reinforce your learning by reviewing the summaries at the end of each 
activity

Need Help?

If you require assistance in using Prinergy Evo, refer to the documents referenced 
throughout this guide, including the Prinergy Evo Help.

You can also contact a service representative:

http://graphics.kodak.com/us/contact_us/default.htm.

eCentral

Kodak eCentral®, the Internet portal, for customers with Kodak service 
agreements:

https://ecentral.graphics.kodak.com.

Note: You will complete these activities faster and learn more if you have completed the Learning 
Prinergy Evo Web-based Training on the Kodak Prinergy Evo Training DVD.

http://graphics.kodak.com/us/contact_us/default.htm
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Supporting Resources

Note: Documentation is also available in PDF format at https://ecentral.graphics.kodak.com

Documentation/URL

Prinergy Evo Release Notes

Prinergy Evo Quick Reference Card 2

Prinergy Evo Installation Guide

Prinergy Evo Administrator Help

Prinergy Evo System Administrator Guide

Prinergy Evo Client Help

Kodak Prinergy® Virtual Proofing System (VPS) software  Help

Harmony 1.2 User Guide

Kodak Prinergy® Separation Viewer help file (Kodak plug-in to Adobe® Adobe® 
Acrobat)

Kodak Prinergy® PDF Trap Editor Plug-in Help (Kodak plug-in to Acrobat)

Kodak Prinergy® PDF Trap Editor Plug-in Quick Start Guide (Kodak plug-in to 
Acrobat)

Kodak Prinergy® View Accelerator Plug-in Help (Kodak plug-in to Acrobat)

Kodak Prinergy® Geometry Editor Plug-in Help (Kodak plug-in to Acrobat)

Preps 5.2 or later User Guide

Preps 5.2 or later Learning Guide 5

Preps 5.2 or later Help
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Preparing for Task-Oriented Activities

Before beginning the Prinergy Evo task-oriented activities, you must connect to 
the Prinergy Evo JobData and Hotfolders shared file server volumes with Mac OS 
X. Next, you must copy the practice files from the Task-Oriented Activities folder 
to your Prinergy Evo server.

Preparing to Do the Task-Oriented Activities on Mac OS X: 

1. Insert the Kodak Prinergy Evo 4.0 Training DVD into the DVD drive on your 
client computer. 

2. Connect to the shared file server volumes on your Prinergy Evo server.

a. From the Go menu, select Connect to Server.

b. In the Connect to Server dialog box, in the Address field, type the IP 
address of your Prinergy Evo server. The service representative installing 
your Prinergy Evo system or your system administrator can identify this 
address.

c. In the Connect to the file server dialog box, type your user name and 
password, and then click Connect.

3. From the list of available shared file server volumes, select both JobData and 
HotFolders. Click OK.

The JobData and HotFolders icons will appear on your desktop.

The JobData shared file server volume is where you will store most files used 
in the Prinergy Evo workflow. The HotFolders shared file server volume is 
where you will find the hot folders that you use in your Prinergy Evo workflow.

4. Open the shared JobData volume on your desktop. 

5. Create a new folder on your Prinergy Evo JobData shared file server volume 
and assign a unique name—for example JobData\[Your Name]. 

6. From your desktop, find and open the Prinergy Evo Training DVD. 

7. Select the Task-Oriented Activities folder from the Prinergy Evo Training 
DVD, and drag it to copy it to your new folder.

8. View the Task-Oriented Activities folder in the shared JobData volume. This 
is where you will now find all source files needed to complete the Prinergy Evo 
Task-Oriented activities. 

You can now eject the Prinergy Evo Training DVD from the CD-ROM drive on 
your computer.

You are now ready to start the hands-on Prinergy Evo Task-Oriented 
activities!
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AC
TI

VI
TY

Using the Template Palette to Output a PDF 
File to Preview

Who Should Complete This Activity
• Prepress operators outputting proofs and plates

• Proof operators and plate operators

Why You Should Complete This Activity
Activity 1 introduces you to the procedures used to output PDF files via the 
template palette. The template palette allows you to access multiple process 
templates in one location. This output submission process can be used to output 
preview files, or to output to a proofing or platesetting device.

In this activity you will output a PDF file to a preview file, and then view the 
preview file in the Prinergy Virtual Proofing System software.

Recommended Reading
• Preparing for Task-Oriented Activities on page 11 of this guide.

• Prinergy Evo Help: Supported Output Files

• Prinergy Evo Help: Previewing PDF Files via the Prinergy Virtual Proofing 
System software

Time to Complete This Activity
• Approximately 10 to 15 minutes
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Using the Template Palette to Output a PDF File 
to Preview

What You’ll Learn

You will learn how to use a default output process template to output supplied 
PDF files using a template palette. PDF files will be output to proof, using Prinergy 
Virtual Proofing System software.

What You’ll Do

What You’ll Need

For this practice activity, you must: 

• Open the shared JobData volume on your Prinergy Evo Server 

• Open the Task-Oriented Activities\Activity 01 folder

• Find Wells.p3.pdf and Wells.p4.pdf

A
ct

iv
ity 1

Locate PDF  
files for output

1 Create an 
Output Template Palette 
2 Drag PDF files to the 

output process  
template 

Monitor the output
process status

3 4 5  Locate and view 
output .VPS preview files

JobData

Prinergy Evo 
server

VPS

VPS
VPS

Job
Data

Important: Complete Preparing for Task-Oriented Activities on page 11 of this guide prior to 
completing any activities. This describes how to copy all activity practice files to your system.
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A

Create a New Template Palette

1. Start the Prinergy Evo client application.

2. From the Window menu, select New Template Palette.

3. In the New Template Palette dialog box, in the Name box, type a name for the 
template palette. Click OK. 

The new template palette appears.

4. In the Customize Template Palette dialog box, find the Output from PDF-VPS-
Factory process template stored in the Output from PDF process template 
group: 

5. Drag the Output from PDF-VPS Factory process template to the template 
palette.

6. View your template palette with the Output from PDF-VPS-Factory icon.

7. Close the Template Browser.

Output PDF Files to Preview

1. Open the shared JobData file server volume, then open the Task-Oriented 
Activities\ Activity 01 folder. Find the PDF files: 

Wells.p3.pdf and Wells.p4.pdf

2. Select both Wells.p3.pdf and Wells.p4.pdf and drag them to the Output PDF-
VPS icon in your new template palette.

3. In the Process Start dialog box, verify that the correct PDF files and process 
template are selected. Click Go.

4. If the Process Viewer is not already open, from the Window menu select New 
Process Viewer. Select Wells.p3.pdf and Wells.p4.pdf and view the status of 
the output process in the bottom of the Process Viewer window.

Prinergy Evo generates several Prinergy Virtual Proofing System software 
preview files with the file extension .VPS for each of the PDF input files. 

5. To find the Prinergy Virtual Proofing System software preview files, open the 
shared JobData file server volume, then open the Task Oriented Activities\ 
Activity 01 folder.

Activity: Apply What You Know

Note: The Prinergy Virtual Proofing System software preview files are placed in the location 
specified in the Output from PDF-VPS-Factory process template. In this process template, the 
output location of the VPS files is set to be the same location as the input source files.
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Inspect Preview Files with Prinergy Virtual Proofing System software

1. Double-click any file with the file extension.VPS to automatically start 
Prinergy Virtual Proofing System software.

2. Inspect the preview files generated for Wells.p3.pdf and Wells.p4.pdf. You 
may view each color separation alone, or several separations together.

3. From the Zoom menu in Prinergy Virtual Proofing System software, select the 
Fit to Window view.

See Prinergy VPS Software User Guide for detailed information.

4. After viewing the preview files, Quit Prinergy Virtual Proofing System 
software (Exit on a Windows platform) and return to Prinergy Evo.

Optional: Delete Template Palette

This procedure is optional. Complete this procedure if the template palette 
created for this activity will not be used in your workflow. 

1. From the Window menu, select Template Palettes, then select Edit This List.

2. In the Edit Palette Windows dialog box, select the template palette you 
created, then select Delete.

3. After the template palette is deleted, close the Edit Palette Windows dialog 
box.

Activity Summary
In Activity 1, you output two PDF files as Prinergy Virtual Proofing System 
software preview files. Both PDF files were output using a template palette. 

You proofed the preview files using Prinergy Virtual Proofing System software.
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Output a PDF Using a Hot Folder 

Who Should Complete This Activity
• Prepress operators outputting proofs and plates

• Proof operators and plate operators

Why You Should Complete This Activity
Activity 2 explores the procedure to output PDF files using a hot folder. Hot 
Folders may be used to create a simple automated workflow, allowing users to 
process files without interacting with the Prinergy Evo client. This output 
submission process can be used to output preview files, or to output to a 
proofing or platesetting device.

This activity will provide you with a chance to output a PDF file and create a VPS 
preview file which can then be viewed using Prinergy Virtual Proofing System 
software.

Recommended Reading
• Preparing for Task-Oriented Activities on page 11 of this guide.

• Prinergy Evo Help: Configuring Hot Folders.

Time to Complete This Activity
• Approximately 10 to 15 minutes
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Output a PDF Using a Hot Folder

What You’ll Learn

You will learn how to use a default output process template to output supplied 
PDF files using a hot folder. PDF files will be output to proof, using Prinergy Virtual 
Proofing System software.

What You’ll Do

What You’ll Need

For this practice activity, you must: 

• Open the shared JobData volume on your Prinergy Evo Server 

• Open the Task Oriented Activities\Activity 02 folder

• Locate Wells.p5.pdf and Wells.p6.pdf
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Important: Complete Preparing for Task-Oriented Activities on page 11 of this guide prior to 
completing any activities. This describes how to copy all activity practice files to your system.
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Create a New Hot Folder

1. In the Prinergy Evo Client Help, read the topic Configuring Hot Folders to learn 
about how hot folders work in Prinergy Evo and how to benefit from using 
them in your workflow. 

2. From the Prinergy Evo Configure menu, select Hot Folders.

3. In the Hot Folders dialog box, click New.

4. In the Browse for Folder dialog box, Locate the shared HotFolders volume on 
your the Prinergy Evo server by browsing over the network.

5. Once you have found the shared volume, click Browse and after highlighting 
the HotFolders shared volume, click Make New Folder.

6. In the New Folder dialog box, type a name for your hot folder. Click OK.

7. In the New Hot Folder dialog box, verify the path to your new hot folder.

8. To select a process template to use with this hot folder, click Add. The Assign 
process template dialog box opens.

9. In the Assign process template dialog box, expand the Output PDF process 
template group. Select the Output from PDF-VPS-Factory process template, 
and then click OK.

10. In the Hot Folders dialog box, view the details of the hot folder you created. 
When you have finished viewing these details, close the dialog box by clicking 
the OK button.

At this point, you have:

– Created and named a hot folder in the HotFolders shared file server 
volume.

– Assigned an output process template to the new hot folder.

Activity: Apply What You Know

Note:  The procedure for creating a hot folder may be slightly different with different versions of 
Prinergy Evo software. The following procedure uses Prinergy Evo 4.0 software. 

Note: If you don’t have the shared HotFolders volume mounted on your desktop, see Preparing for 
Task-Oriented Activities on page 11 of this guide.
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Output PDF Using a Hot Folder

1. Open the shared HotFolders file server volume and find the hot folder you 
created.

2. Open the shared JobData volume, then find Task Oriented 
Activities\Activity 02\Wells.p5.pdf and Wells.p6.pdf

3. Select Wells.p5.pdf and Wells.p6.pdf and drag them to the hot folder you 
created in the shared HotFolders volume.

4. If the Process Viewer window is not already open, from the Window menu, 
click New Process Viewer. Select the process and view the status of the 
output process in the bottom of the Process Viewer window.

5. When the output process is complete, return to the shared HotFolders volume 
to view the output preview files inside the hot folder you created.

Notice that the preview files are in the Output folder, and the original PDF 
files are in the Input_Success folder.

For explanation of the other default folders that are a part of every hot folder 
created in Prinergy Evo, refer to Configuring Hot Folders in the Prinergy Evo  
Help.

6. In the Output folder, select the six preview files for Wells.p5.pdf. Double-click 
any of the files to automatically start Prinergy Virtual Proofing System 
software. View the preview files.

Consult the Prinergy VPS Software User Guide for more detailed information.

7. After viewing the preview files, Quit or Exit Prinergy Virtual Proofing System 
software.

Optional: Delete a Hot Folder

This procedure is optional. Complete this procedure if the hot folder created for 
this activity will not be used in your workflow. 

1. Using a file manager such as Windows Explorer or the Mac OS Finder, browse 
to the Hot Folder you created in this exercise.

2. Delete all files residing in the Output subfolder and the Input_Success 
subfolder.

3. From the Prinergy Evo Configure menu, select Hot Folders. 

4. In the Hot Folders dialog box, select the hot folder you created, then click 
Delete.

5. In the shared HotFolders volume, select the hot folder.

Note: If you don’t have the shared file server volumes mounted on your desktop or visible to your 
client workstation, see Preparing for Task-Oriented Activities on page 11 of this guide.
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6. If you want to remove the folder from your Prinergy Evo server computer, 
locate the Hot Folders shared file server volume and delete the folder.

Activity Summary
In Activity 2 you output two PDF files to preview files. Both PDF files were output 
using a hot folder. You proofed the preview files using software.

Note: If you attempt to delete a Hot Folder using the Prinergy Evo client before you have deleted all 
files from within the subfolders within the Hot Folder, you will see the following warning

The Prinergy Evo server has reported on error. Stopped monitoring Hot 
Folder \\squarepusher\hotfolders\Activity Two, but failed to delete 
its directory because on or more of its subdirectories may still 
contain files.

This is expected behavior alerting you to the fact that the hot folder contained files. These files and 
the subfolders that contained them will not be deleted until you manually delete them with a file 
browser or use other Prinergy Evo client mechanisms to delete the files.
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Refine a PostScript file to PDF using the 
Template Palette 

Who Should Complete This Activity
• Prepress operators

Why You Should Complete This Activity
Activity 3 introduces you to the refine process used in the Prinergy Evo workflow.

This activity will have you refine a PostScript file to PDF, then view the newly 
refined PDF file using Acrobat.

This activity demonstrates how files can be refined using the template palette.

Recommended Reading
• Preparing for Task-Oriented Activities on page 11 of this guide.

• Prinergy Evo Help: Submitting Files to the Template Palette.

Time to Complete This Activity
• Approximately 10 to 15 minutes
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Refine a PostScript File to PDF Using the 
Template Palette

What You’ll Learn

You will learn how to refine an input file (PostScript) to PDF using a template 
palette. The PDF file will be viewed in Acrobat following the refine process.

What You’ll Do

What You’ll Need

For this practice activity, you must: 

• Open the shared JobData volume on your Prinergy Evo Server 

• Open the Task Oriented Activities\Activity 03 folder

• Locate Money Card.ps
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Important: Complete Preparing for Task-Oriented Activities on page 11 of this guide prior to 
completing any activities. This describes how to copy all activity practice files to your system.
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Create a new Refine process template

1.  From the Prinergy Evo Window menu, select New Template Palette.

2. In the New Template Palette dialog box, type a name for the template palette. 
Click OK.

3. In the Template Browser dialog box, find the RefineToPDF-Factory process 
template in the Refine To PDF process template group.

4. Drag the RefineToPDF-Factory process template to the new template palette.

5. View the RefineToPDF-Factory process template icon in the template palette. 

Refine Input Files to PDF Using the Template Palette

1. Open the shared JobData volume and find \Task Oriented 
Activities\Activity 03\Money Card.ps.

2. Select Money Card.ps and drag it to the template palette.

3. In the Process Start dialog box, check that the correct PostScript input file and 
process template have been selected. After checking your selection, click Go.

4. If the Process Viewer window is not already open, from the Window menu, 
select New Process Viewer. View the status of the refine process in the 
bottom of the Process Viewer window.

5. You may notice the Warning status of the refine process in the Process 
Viewer window. To view a detailed explanation of the warning, select the 
process and from the View menu, click Item History.

The warning message indicates that Prinergy Evo encountered a low-
resolution image and a PANTONE® color whose color recipe was not defined.

6. To find the refined PDF files, open the shared JobData file server volume, then 
find \Task Oriented Activities\Activity 03.

View PDF Output Files in Acrobat

1. In the \Task Oriented Activities\Activity 03 folder, select both PDF files, 
then double-click them. This automatically starts Acrobat software. 

2. View the files in Acrobat. See Supporting Resources on page 10 of this guide for 
a list of available resources for Kodak plug-ins to Acrobat.

3. After viewing the PDF files, Quit or Exit Acrobat and return to Prinergy Evo.

Activity: Apply What You Know

Note: The PDF output files are placed in the location specified in the RefinetoPDF process template. 
In this process template, the output location of the refined PDF files is set to be the same location as 
the input source files.
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Optional: Delete Template Palette

This procedure is optional. Complete this procedure if the template palette 
created for this activity will not be used in your workflow. 

1. From the Window menu, select Template Palettes, then select Edit This List.

2. In the Edit Palette Windows dialog box, select the template palette you 
created, then select Delete.

3. After the template palette is deleted, close the Edit Palette Windows dialog 
box.

Activity Summary
In Activity 3 you refined a PostScript input file into two PDF files. The PDF files 
were generated using a template palette. You then viewed the PDF files using  
Acrobat.
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Refine a PostScript Input File to PDF Using a 
Hot Folder

Who Should Complete This Activity
• Prepress operators 

Why You Should Complete This Activity
Activity 4 furthers your introduction to the refine process used in the Prinergy Evo 
workflow.

This activity will allow you to refine a PostScript file to PDF, then view the newly 
refined PDF file using Acrobat.

This activity demonstrates how files can be refined using a hot folder.

Recommended Reading
• Preparing for Task-Oriented Activities on page 11 of this guide.

• Prinergy Evo Help: Refining Input Files.

Time to Complete This Activity
• Approximately 10 to 15 minutes
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Refine a PostScript Input File to PDF 
Using a Hot Folder

What You’ll Learn

You will learn how to refine an input file (PostScript) to PDF using a hot folder. You 
will then view the PDF file in Acrobat.

What You’ll Do

What You’ll Need

For this practice activity, you must: 

• Open the shared JobData volume on your Prinergy Evo Server 

• Open the Task Oriented Activities\Activity 04 folder

• Locate Sales Flyer.ps
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Important: Complete Preparing for Task-Oriented Activities on page 11 of this guide prior to 
completing any activities. This describes how to copy all activity practice files to your system.
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Create a New Hot Folder

1. In the Prinergy Evo Client Help, read the topic Configuring Hot Folders to learn 
about how hot folders work in Prinergy Evo and how to benefit from using 
them in your workflow. 

2. From the Prinergy Evo Configure menu, select Hot Folders.

3. In the Hot Folders dialog box, click New.

4. In the Browse for Folder dialog box, locate the shared HotFolders volume on 
the network.

5. Once you have found the shared volume, click New Folder.

6. In the New Folder dialog box, type a name for your hot folder. Click Create.

7. In the Locate the Hot Folder dialog box, select the hot folder you created. Click 
Choose.

8. In the New Hot Folder dialog box, verify the path to your new hot folder.

9. To select a process template to use with this hot folder, click Add. The Assign 
process template dialog box opens.

10. In the Assign process template dialog box, expand the Refine to PDF process 
template group. Select the RefineToPDF-Factory process template, and then 
click OK.

11. In the Hot Folders dialog box, view the details of the hot folder you created. 
When you have finished viewing these details, close the dialog box.

Refine a PostScript Input File Using the New Hot Folder

1. Open the shared HotFolders volume and locate the hot folder you created.

2. Open the shared JobData volume and locate:

Task Oriented Activities\Activity 04\Sales Flyer.ps.

3. Select the Sales Flyer.ps file, then drag it to the hot folder you created in the 
shared HotFolders volume.

Activity: Apply What You Know

Note:  The procedure for creating a hot folder may be slightly different with different versions of 
Prinergy Evo software. The following procedure uses Prinergy Evo 4.0 software. 

Note: If you can’t locate the shared HotFolders volume, see Preparing for Task-Oriented Activities on 
page 11 of this guide.
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4. If the Process Viewer window is not already open, from the Window menu, 
select New Process Viewer. View the status of the refine process in the 
bottom of the Process Viewer window.

5. When the refine process is complete, return to the shared HotFolders volume 
and view the Salesflyer.ps.pdf file. Notice that the PDF file is located in the 
Output folder, and the original PostScript file is located in the Input_Success 
folder.

6. In the Output folder, double-click the PDF file. Acrobat software will start.

Optional: Delete a Hot Folder

This procedure is optional. Complete this procedure if the hot folder created for 
this activity will not be used in your workflow. 

1. Using a file manager such as Windows Explorer or the Mac OS Finder, browse 
to the Hot Folder you created in this exercise.

2. Delete all files residing in the Output subfolder and the Input_Success 
subfolder.

3. From the Prinergy Evo Configure menu, select Hot Folders. 

4. In the Hot Folders dialog box, select the hot folder you created, then click 
Delete.

5. If you want to remove the folder from your Prinergy Evo server computer, 
locate the Hot Folders shared file server volume and delete the folder.

Activity Summary
In Activity 4 you created a hot folder connected to a refine process plan. You 
refined a PostScript input file into a PDF file using the new hot folder, then viewed 
the file using Acrobat.
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Mapping PostScript Spot Colors 

Who Should Complete This Activity
• Prepress operators 

Why You Should Complete This Activity
Activity 5 introduces you to the spot color handling features available in the 
Prinergy Evo workflow. This activity introduces you to using the refine process to 
determine which spot colors are defined in your PostScript input file, then using a 
second refine process to map one spot color to another to reduce the number of 
spot colors in your final PDF file. 

You will practice a workflow that will be helpful if the spot colors in your 
composite input files don't match the spot colors that you need for output, or if 
you don't know what spot colors are in your input files. 

Recommended Reading
• Prinergy Evo Help: Handling Spot Colors

• Prinergy Evo Help: Reducing Spot Colors During Refine

• Trap Viewer Plug-in Help

• Trap Editor Plug-in Quick Start Guide 

Time to Complete This Activity
• Approximately 15 to 20 minutes
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Mapping PostScript Spot Colors

What You’ll Learn

You will learn how to determine which spot colors are defined in a PostScript 
input file. You will learn how to map one spot color to another using the refine 
process.

What You’ll Do

What You’ll Need

For this practice activity, you must: 

• Open the shared JobData volume on your Prinergy Evo Server 

• Open the Task Oriented Activities\Activity 05 folder
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• Locate PrintBuyerGuide.ps

 

Refine PostScript Input Files

1. Open the shared JobData volume on your desktop and find \Task Oriented 
Activities\Activity 05\ PrintBuyerGuide.ps. 

2. From the Prinergy Evo client Configure menu, select Process Templates.

3. In the Process Template Editor dialog box, select a refine process template 
from the Process Templates\Factory Templates\Refine to PDF group. You 
may use the default RefinetoPDF - Factory process template installed with 
the system. 

4. In the Refine to PDF\Refine to PDF - Factory process template dialog box, 
verify spot color handling options For this step, Don’t Map Spot Colors should 
be selected. The correct settings for spot color handling are shown here:

 
5. Close the Refine to PDF - Factory process template. Do not save it.

6. Submit PrintBuyerGuide.ps to the Refine to PDF - Factory process template. 
Use your preferred method to submit the file. You may use a template palette, 
hot folder, the File menu, or the Template Browser.

Important: Complete Preparing for Task-Oriented Activities on page 11 of this guide prior to 
completing any activities. This describes how to copy all activity practice files to your system.

Activity: Apply What You Know
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7. In Acrobat, check the resulting PDF pages. 

a. Select the Prinergy Separation Viewer plug-in. 

b. Note which spot colors are used. 

Map Spot Colors in PDF Files Using the Refine Process 

1. Locate the refined PDF pages and submit these refined PDF pages to the 
Refine to PDF - Factory process template: 

PrintBuyerGuide.p0001.pdf

PrintBuyerGuide.p0002.pdf

PrintBuyerGuide.p0003.pdf 

PrintBuyerGuide.p0004.pdf

2. In the Process Start dialog box, click Settings. The Spot Color Mapping list 
will appear in the Process Template Settings dialog box.

The Colors section of the Process Template Settings dialog box lists all colors 
defined in the input files. This job should output six colors (Cyan, Magenta, 
Yellow, Black, PANTONE 703C, PANTONE 648C). We will map two of the 
eight colors to two other colors.

3. In the Spot color mapping dialog box, map spot color names so only the 
required colors will print. 

The Prinergy Separation Viewer is a Kodak plug-in to Acrobat. For more information about using this 
plug-in, see the Prinergy Separation Viewer help file (Acrobat > Help > Plug-In Help > Prinergy 
Separation Viewer). 

Note: The first time you access the Process Template Settings dialog box, Prinergy Evo loads the 
color libraries. This may take from 30 seconds to a few minutes.
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a. In the Color list, select PANTONE 648C, then in the Action list, select 
PANTONE 355 C. 

Any object in the PDF files which was originally colored PANTONE 648CV 
will now be colored PANTONE 355 CV. 

b. In the Color list, select PANTONE Orange 021, then in the drop-down 
menu, select PANTONE 703 C. 

c. Click OK.

4. In the Process Start window, click Go.

5. View the status of the refine process in the Process Viewer window.

6. Click Item History to view the detailed information about how Evo has refined 
the PDF pages successfully.

7. Prinergy Evo has created new PDF pages. Note that the existing files have not 
been overwritten. Prinergy Evo adds a new extension to identify the new files:   

PrintBuyerGuide.p0001.new.pdf, 

PrintBuyerGuide.p0002.new.pdf

PrintBuyerGuide.p0003.new.pdf

PrintBuyerGuide.p0004.new.pdf

You may now trap these new PDF pages, or submit them for low-resolution or 
high-resolution output.

Activity Summary
In Activity 5 you refined a PostScript input file which contained unknown spot 
colors. You then refined the resulting PDF pages. During the second refine, you 
mapped two spot colors in the PDF pages reducing the number of spot colors in 
the file set from eight to six. The new PDF pages can now be trapped or submitted 
for low-resolution or high-resolution output. 

Note: If you prefer, you can select one of the spot colors and select Convert to process. 
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Building an Output Process Template

Who Should Complete This Activity
• Prepress operators

• System administrators

Why You Should Complete This Activity
Activity 6 introduces you to building process templates in Prinergy Evo. It 
highlights the options available when building an output process template using 
the Process Template Editor.

A process template is required for every process executed in a Prinergy Evo 
workflow. 

Recommended Reading
• Preparing for Task-Oriented Activities on page 11 of this guide

• Prinergy Evo Help: What is the Process Template Editor

Time to Complete This Activity
• Approximately 15 to 20 Minutes
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Building an Output Process Template

What You’ll Learn

You will learn how to build an output process template using the Process 
Template Editor. You will access the output process template via the File menu to 
output supplied PDF files to Prinergy Virtual Proofing System software preview 
files.

What You’ll Do

What You’ll Need

For this practice activity, you must: 

• Open the shared JobData volume on your Prinergy Evo Server 

• Open the Task Oriented Activities\Activity 06 folder

• Find Wells.p1.pdf   
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Important: Complete Preparing for Task-Oriented Activities on page 11 of this guide prior to 
completing any activities. This describes how to copy all activity practice files to your system.
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Create a New Output Folder

1. On your desktop, open the shared JobData volume.

2. With the JobData volume open and highlighted, select New Folder from the 
File menu.

3.  In the JobData window, name the new folder Activity Output. You will 
configure a process template to output PDF files to this folder.

Configure an Output Process Template

1. Start Prinergy Evo.

2. Start Process Template Editor by selecting Process Templates from the 
Configure menu.

3. In the Process Template Editor window, view the default process templates in 
the Output from PDF process template group.

4. Create new process template group.

5. From the Process Template Editor File menu, select Output from PDF 
Template.

6. In the Output PDF process template dialog box, view the eight available 
sections used to configure the parameters of a process template. Select an 
icon at the top of the dialog box or click the triangle to view the section’s 
options.

To learn more about the settings available in each section, click the context-
sensitive help button. 

7. From the Output To list, select Virtual Proof.

8. Select the Match Colors check box to activate settings in the Color Matching 
section.

9. Click the drop-down arrow in File Delivery, select the Send Processed file to... 
option and then click Browse.

a. In the File Browser window double-click the JobData volume. 

b. In the JobData volume, select the Activity Output folder. 

10. In the Processed File Preferences section, verify that the entry in the Device 
Path box is: [JobData]\Activity Output.

This path determines the location of the output file once processed.

11. From the Process Template Editor File menu, select Save.

12. In the Save Process Template dialog box, select the Output from PDF process 
template group, as the “home” of the new process template.

Activity: Apply What You Know
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13. Type a name for the new process template, then click Create Process 
Template.

14. View the new process template in the Prinergy Evo Process Template Editor. 
Close the Process Template Editor after viewing.

Output PostScript files to PDF Virtual Proof

1. From the Prinergy Evo File menu select Output from PDF.

2. In the Select Input Files dialog box, select JobData\Task Oriented 
Activities\Activity 06 \Wells.p1.pdf. Click Open.

3. In the Process Templates dialog box, select the output process template that 
you created, then click OK.

4. In the Process Start dialog box, verify that the correct input file and process 
template have been selected. Click Go.

5. From the Prinergy Evo Window, select New Process Viewer (unless it is 
already open). View the status of the output process in the bottom of the 
Process Viewer window.

Close the Process Viewer window when processing is complete.

6. Open the Activity Output folder you created in the shared JobData file server 
volume. You will see Prinergy Virtual Proofing System software preview files 
created by Prinergy Evo during the output process.

7. Select the four preview files, then double-click to start Prinergy Virtual 
Proofing System software. For PC, you select all four files, right-click and then 
click Open.

8. From the Zoom menu in Prinergy Virtual Proofing System software, select the 
Fit To Window view.

9. After viewing the preview files, quit Prinergy Virtual Proofing System 
software.

Optional: Delete a Process Template

This procedure is optional. Complete this procedure if the output PDF process 
template created for this activity will not be used in your workflow. 

1. In the Process Template Editor window, select the output process template 
that you created.

2. From the File menu, select Delete.

3. Click Delete when asked if you really want to delete the process template.

Consult the Prinergy VPS Software User Guide for detailed information on using this software.
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Activity Summary
In Activity 6 you created a new folder where an output process template could 
send processed files. You then created a new output process template using the 
Process Template Editor. You used the new process template to output a supplied 
PDF file as preview file.
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Personal Notes
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Building a Refine Process Template 

Who Should Complete This Activity
• Prepress operators

• System administrators

Why You Should Complete This Activity
Activity 7 introduces you to the process of building refine process templates in 
Prinergy Evo. It highlights the options available when building a refine process 
template using the Process Template Editor.

A process template is required for every process executed in a Prinergy Evo 
workflow. 

Recommended Reading
• Preparing for Task-Oriented Activities on page 11 of this guide.

• Prinergy Evo Help: What is the Process Template Editor?

• Prinergy Evo Help: Refining Input Files

Time to Complete This Activity
• Approximately 15 to 20 minutes
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Building a Refine Process Template

What You’ll Learn

You will learn how to build a refine process template using the Process Template 
Editor. The refine process template will be used to refine a supplied PostScript file. 
You will use the File menu to submit a PostScript file for output to PDF.

What You’ll Do

What You’ll Need

For this practice activity, you must: 

• Open the shared JobData volume on your Prinergy Evo Server 

• Open the Task Oriented Activities\Activity 07 folder

• Find Maine Flyer.ps
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Important: Complete Preparing for Task-Oriented Activities on page 11 of this guide prior to 
completing any activities. This describes how to copy all activity practice files to your system.
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Configure a Refine Process Template

1. Start the Prinergy Evo client if it is not already running.

2. Start the Process Template Editor by selecting Process Templates from the 
Configure menu.

3. In the Prinergy Evo Process Template Editor, view the default Factory process 
templates in the Refine to PDF process template group.

4. From the Process Template Editor File menu, select New Refine to PDF 
Template.

5. In the Refine to PDF process template dialog box, view the ten available 
sections used to configure the parameters of a process template. Select an 
icon at the top of the dialog box or click the triangle to view the section’s 
options.

To learn more about the settings available in each section, click the context-
sensitive help button. 

6. From the Generate list at the top of the Process Template, choose PDF.

7. In the Overprint Conversion section, select the Set Black to Overprint check 
box.

8. In the File Delivery section, select Send PDF Files to, then click Browse.

a. In the File Browser, click the Volumes button.

b. Select the JobData volume and double-click on it.

c. Click the New Folder button. In the dialog box that appears, type 
Activity 7 Refined PDFs and click OK. 

d. In the File Browser, select the Activity 7 Refined PDFs folder and click 
Select

9. In the Processed File Preferences section, verify that the entry in the Device 
Path box is: [JobData]\Activity 7 Refined PDFs.

This path determines the location of the output file once processed.

10. From the Process Template Editor File menu, select Save.

11. In the Save Process Template dialog box, select the Process Templates 
process template group as the “home” of the new process template.

12. Type a name for the new process template, then click Create Process 
Template.

13. View the new process template in the Prinergy Evo Process Template Editor. 
Close the Process Template Editor after viewing.

Activity: Apply What You Know
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Refine PostScript Input Files to PDF

1. From the Prinergy Evo File menu select Refine Files to PDF.

2. In the Select Input Files dialog box, browse to and select JobData\Task 
Oriented Activities\Activity 07 \Maine Flyer.ps. Click Open.

3. In the Select a Template dialog box, select the Refine process template that 
you created, then click OK.

4. In the Process Start dialog box, verify that the correct input file and process 
template have been selected. Click Go.

5. From the Prinergy Evo Client, click the View by Process button. View the 
status of the output process in Process Viewer window.

6. Open the Activity 7 Refined PDFs folder you created in the shared JobData 
file server volume. You will see the Maine Flyer.pdf created by the refine 
process.

7. Double-click the PDF file to start Acrobat.

After viewing the PDF file, close Acrobat.

Optional: Delete a Process Template

This procedure is optional. Complete this procedure if the output PDF process 
template created for this activity will not be used in your workflow. 

1. In the Prinergy Evo Process Template Editor window, select the output 
process template that you created.

2. From the File menu, select Delete.

3. Click Delete when asked if you really want to delete the process template.

Activity Summary
In Activity 7 you created a new folder where a refine to PDF process template 
could send processed files. You then created a new refine process template using 
the Process Template Editor. You used the new process template to refine a 
supplied PostScript file to PDF.
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Personal Notes
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Customize Evo Workflows With a Template 
Palette

Who Should Complete This Activity
• Prepress operators

• System administrators

Why You Should Complete This Activity
Activity 8 assists you to plan and organize your most common workflow steps 
using the template palette. In this activity you will consider the benefit of using a 
set of standard process templates that suit most of your work. Once configured, 
a template palette enables you to drag files from mounted volumes on Prinergy 
Evo Client computer to the template palette for processing. 

You may wish to have one template palette that contains all of your frequently-
used process templates, or you may decide to have several template palettes.

Recommended Reading
• Prinergy Evo Help: Creating and Configuring Template Palettes.

• Optional — Activity 1: Using the Template Palette to Output a PDF File to Preview 
on page 13 of this guide.

• Optional — Activity 3: Refine a PostScript file to PDF using the Template Palette 
on page 25 of this guide.

Time to Complete This Activity
Approximately 10 to 15 minutes
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Customize Prinergy Evo Workflows With a 
Template Palette

What You’ll Learn

You will learn how to configure a template palette to organize and automate 
workflow steps for your production work.

What You’ll Do

What You’ll Need

For this practice activity, you must identify and create process templates to suit 
your workflow requirements. For more information, see Prinergy Evo Help: What 
Is the Process Template Editor?
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Customizing the Template Palette

1. From the Window menu, select New Template Palette.

2. In the New Template Palette dialog box, in the Name box, type a name for the 
template palette. Use a name that represents how you will use the template 
palette in your workflow—for example, Process Color Workflows. 

3. Select the Configure now check box. 

4. Click OK.

5. In the Customize Template Palette dialog box, select and drag a process 
template onto the new template palette. 

For example, from the Factory Templates\Refine to PDF folder, drag the 
process template RefinetoPDF-ConvertSpots to the template palette. This 
template will refine a PostScript or PDF input file and convert it to a PDF. The 
Refine process will convert any spot colors into process colors, using the color 
library information in the system.

6. Select additional process templates that you will frequently use in your 
workflow. Drag each of your selected process templates to the template 
palette. 

For example, drag the process template OutputPDF-VPS-2up.

Next you can drag the process template OutputImposition-VPS.

7. Close the Customize Template Palette dialog box when you have added all the 
necessary process templates to your template palette.

The template palette is now available to all your Prinergy Evo users. You can 
drag files onto the process templates in the template palette for processing. 

Activity: Apply What You Know
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Note that the working folders that store input files must be accessible to the    
Prinergy Evo server computer. Otherwise, the system will not be able to 
process input files. 

 

Activity Summary
In Activity 8, you created a template palette to organize the process templates 
you use most frequently. 

Personal Notes
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Complete a Page-Based PDF Imposition 
Workflow Using Preps

Who Should Complete This Activity
• Prepress operators

• System administrators

Why You Should Complete This Activity
Activity 9 introduces the procedures used to create and submit a PDF imposition 
file from Kodak Preps® digital imposition software to Prinergy Evo. 

Preps allows you to organize PDF and PostScript pages into reader order and 
associate the pages with templates representing each signature in your print job. 
Preps then creates an imposition file that contains all the information required by 
Prinergy Evo for output. 

In this activity you will practice the recommended PDF-to-PDF workflow with 
Preps 5.2 or later. For other workflows, please refer to Prinergy Evo Help: 
Submitting Preps Files.

Recommended Reading
• Preps 5.2 User Guide: Printing to an Adobe Job Ticket or a JDF File

• Prinergy Evo Help: Creating and Using Imposition Plans

• Prinergy Evo Help: Creating a PDF to PDF Preps Imposition Plan

• Prinergy Evo Installation Guide

Time to Complete This Activity
• Approximately 40 Minutes



Module 9: Complete a Page-Based PDF Imposition Workflow Using Preps

60  Activities Guide

Complete a Page-Based PDF Imposition 
Workflow Using Preps

What You’ll Learn

First, you will confirm Preps software is configured to correctly create imposition 
files. Next, you will add PDF pages to a Preps job, and associate a Preps 
imposition template. You will submit an imposition file to Prinergy Evo for proof 
output. You will proof the imposition in Prinergy Virtual Proofing System software. 

What You’ll Do
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What You’ll Need

For this practice activity, you must:

• Have Preps 5.2 (or higher) installed. 

• Ensure the Preps Templates and Marks folder is pointing to the Templates 
and Marks folder on the Prinergy Evo server. The location of the Templates 
and Marks folder is \\<servername>\pgyevoconfig\Preps.

• Ensure the Preps Printers folder is pointing to the Preps Printers folder on the 
Prinergy Evo server. The location of the Printers folder is 
\\<servername>\pgyevoconfig\Preps\Printers

• Locate sample PDF pages—for example, \\JobData\Activity 09\input 
files\annualp.0001.pdf.

• Complete Activity 8 in this guide.

Add PDF pages to a new Preps job

In this procedure, you will locate PDF pages then impose them in Preps software. 
Follow these instructions, or refer to Prinergy Evo Help or the Preps User Guide for 
more help:

1. From your Prinergy Evo Client computer, connect to the shared JobData file 
server volume on the Prinergy Evo server.

2. Locate PDF input files in JobData\Task Oriented Activities\Activity 
09\PDFPages.

3. Start Preps.

4. From the File menu, select New Job, then PDF -> PDF. This is the 
recommended workflow for PDF pages. For more information about the 
benefits of this workflow and for alternatives, refer to Prinergy Evo Help: 
Submitting Preps Files.

5. Click Add Files in the Preps job. For this example, add PDF input page: 
annual.0001.pdf through annual.0008.pdf. 

6. Organize the pages in reader order in the Preps Run List window. Consult your 
Preps documentation for more information.

Activity: Apply What You Know

Note: The procedure for preparing files in Preps will differ slightly, depending on your version of 
Preps software and the workflow you are using. This activity uses Preps 5.2, in a PDF to PDF 
workflow that outputs a JDF to Prinergy Evo.



Module 9: Complete a Page-Based PDF Imposition Workflow Using Preps

62  Activities Guide

Prepare a Preps Imposition Plan for Prinergy Evo

In the following procedure, you will associate pages with a Preps layout template, 
then submit the entire imposition plan to Prinergy Evo for output. 

1. At the top of the Signature List window, click Signatures.

2. In the Signature Selection dialog box, assign the signature template. Select a 
template with the required settings for your job. For this activity, choose a 
Perfect Bound binding template. From the Sample Templates folder, browse 
to: US /Letter Tutorial PerfectBound / 8 page WT.

For more detailed information, refer to the Preps User Guide and to Prinergy Evo Help: Imposition 
Plan Rules and Assumptions and Prinergy Evo Help: Creating And Using Imposition Plans
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.
3. Click Add.

4. Click OK.

5. Print the imposition plan to Evo. From the File menu, select Print.... The Print 
dialog box opens.

6. From the Send to list, select JDF. JDF format is recommended for this PDF -
to-PDF workflow.

7. From the Device list, select Press Sheet Size.

8. Click Print.

9. In the Save JDF dialog box, select a location to save your imposition plan.

10. Type a name for the imposition plan—for example, 
Activity09_8pgImposition.PJTF.

Preps will create a JDF file. Prinergy Evo will use the imposition information 
contained in this file. The exported file must be saved in a location that can be 
accessed by the Prinergy Evo server. This ensures Evo can locate all of the 
components required to output the imposition. 

For this activity, save the JDF file in the same folder as your PDF source pages—
for example, \\JobData\Task Oriented Activities\Activity 09.

11. Save the Preps job in: \\JobData\Task Oriented Activities\Activity 09.

Submit the Preps Imposition plan to Evo for Proof or High-Resolution Film 
or Plate Output

For more detailed information, refer to Prinergy Evo Help: Imposition Plan Rules and Assumptions 
and Prinergy Evo Help: Outputting an Imposed Page-Based Proof, Film, or Plate.
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You will now submit the Preps imposition plan to an output from imposition 
process template via the Prinergy Evo template palette.

1. Return to the Prinergy Evo client. 

2. Open the General Workflow template palette you created in Activity 8. 

3. Drag your Activity09_8pgImposition.JDF file to the OutputImposition-VPS 
process template.

4. View the status of the output process in the Process Viewer window. 

Note that the Process Viewer lists each signature and flat separately. Prinergy 
Evo creates one preview file for each film or plate separation. 

5. Locate the preview files for your imposition in the folder where you saved the 
JDF imposition file. Open \\JobData\Task Oriented Activities\Activity 09. 

6. Select all of the Activity09_8pgImposition.PJTF.VPS files. Double-click one 
of these files to automatically start Prinergy Virtual Proofing System software. 

7. View the files in Prinergy Virtual Proofing System software. Quit Prinergy 
Virtual Proofing System software when you have finished viewing the 
imposed preview files.

Activity Summary
In Activity 9 you created a PDF->PDF imposition plan in Preps. 

First, you confirmed that Preps is configured to output to a Kodak system. Next 
you selected input pages and an imposition. Then, you exported the imposition 
plan from Preps to Prinergy Evo. Finally, you submitted the imposition for 
processing in Evo.

Personal Notes
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 Automate Your Workflow Using Hot 
Folders

Who Should Complete This Activity
• Prepress operators

• System administrators

Why You Should Complete This Activity
Activity 10 introduces you to automating your Prinergy Evo workflow using hot 
folders. You have already used hot folders to submit files for automatic refine or 
output. This activity will provide you with a chance to create a hot folder 
workflow which will automatically refine and output.

Recommended Reading
• Prinergy Evo Help: Configuring Prinergy Evo for Refine and Output

• Prinergy Evo Help: Creating a New Hot Folder

• Prinergy Evo Help: Creating a Refine to PDF process template

• Prinergy Evo Help: Refine to PDF process template Options

Time to Complete This Activity
• Approximately 15 to 25 Minutes
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Automate Your Workflow Using Hot Folders

What You’ll Learn

You will learn how to configure an automated workflow using Prinergy Evo hot 
folders. This workflow will allow you to drag a file into a hot folder from your 
desktop so Prinergy Evo will automatically refine the file and create a PDF, then 
automatically output a virtual proof.

This automation functions by connecting two hot folders (and therefore two 
process templates) in sequence. The processed file from the Refine process 
template will be submitted automatically to an output PDF process template.

What You’ll Do

First, you will locate an existing output hot folder or create a new one, like that 
created in Activity 2. This output hot folder should be associated with an output 
process template that creates Prinergy Virtual Proofing System software preview 
files.

Next, you will modify the settings in a refine process template and save it as a 
new process template. This refine process template will send processed files to an 
output hot folder. This means PostScript or PDF files submitted to this refine 
process template will be refined, then automatically sent to the output hot folder 
for further processing into a proof.

Next, you will create a refine-and-proof hot folder and associate it with the new 
refine process template. Any file dropped into that hot folder will automatically 
initiate refine, then output to proof.

Finally, you will test this workflow. You will submit a supplied PostScript file to the 
new refine and proof hot folder. You will monitor the processes as the file is 
refined then proofed. You will then retrieve the completed preview file and proof 
the file on screen.
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What You’ll Do

What You’ll Need

For this practice activity, you must:

• Locate or create a hot folder that is connected to a process template that will 
output preview files. 

• Locate or create refine process template. 

• Locate a sample input file (PostScript or PDF)—for example: \\JobData\Task 
Oriented Activity\Activity 10 \typebrochure.ps.
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Configure an Output Hot Folder

• Locate an existing hot folder that is associated with a process template that 
will output preview files, or configure a new output hot folder. You configured 
a hot folder like this in Activity 2. 

Modify a Refine Process Template to Send Processed Files to the Output 
Hot Folder

1. Using the Prinergy Evo Process Template Editor, open the Refine to PDF - 
Factory process template found in the Process Templates > Factory 
Templates > Refine to PDF group. For more information, refer to Prinergy Evo 
Help: Editing process templates. 

2. Expand the File Delivery section of the process template. In the Send 
Processed Files to: field, browse to your Output Virtual Proofing System hot 
folder. 

3. Save the process template with a new name: (e.g.) Refine for AutoProof. 

Files which have completed processing via this Refine process template will 
be sent automatically the output hot folder for proofing.

Create a Refine and Proof Hot Folder

1. Create a new hot folder. For more information, refer to Prinergy Evo Help: 
Configuring Hot Folders.

2. In the New Hot Folder dialog box, select the Refine and Auto Proof process 
template created above. 

3. Type a name for your new hot folder. Use a name you will recognize. For 
example: Refine for AutoProof. 

Submit an Input file for Automatic Refine and Proof

1. Locate an input file to test your new automatic workflow. Find \\JobData\ 
Task Oriented Activities\Activity 10\TypeBrochure.ps.

2. Drag the input file into the new Refine for AutoProof hot folder. The system 
will automatically refine and then output preview files.

3. Open the Process Viewer. View the status of the refine and output processes.

4. When the output process is complete, return to the shared HotFolders 
volume to view the preview files in the Refine for AutoProof\Output folder.

Activity: Apply What You Know

For more information, refer to Prinergy Evo Help: Creating a New Hot Folder 
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Activity Summary
In Activity 10, you configured a hot folder that links a refine process template and 
an output process template in sequence. You tested the resulting refine and 
automatic proof workflow by submitting an unrefined input file. You observed Evo 
refining then automatically outputting preview files.

Personal Notes
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Automate Your Workflow Using Hot 
Folders and Template Palette

Who Should Complete This Activity
• Prepress operators

• System administrators

Why You Should Complete This Activity
Activity 11 introduces you to automating your Prinergy Evo workflow using the 
template palette and hot folders. In this activity, you will create a template 
palette to initiate the automated workflow you created in Activity 10.

Automating your workflow with hot folders and the template palette can 
increase your efficiency in running jobs through Prinergy Evo.

Recommended Reading
• Prinergy Evo Help: Creating and Configuring Template Palettes

Time to Complete This Activity
Approximately 20 minutes
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Automate Your Workflow Using Hot Folders 
and Template Palette

What You’ll Learn

You will learn how to configure a template palette linked to the automatic refine 
and proof workflow you created in Activity 10. You will then automatically refine 
and proof an input file by submitting via the template palette. 

What You’ll Do
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What You’ll Need

For this practice activity, you must:

• Complete Activity 10 

• Locate a sample input file (PostScript or PDF)—for example: JobData\Task 
Oriented Activities\Activity 11\typebrochure.ps. 

 Create and Configure a Template Palette

1. Create a new template palette. 

Tip: Use a name you will remember and which will describe the purpose of the 
template palette. 

2. Drag the Refine for AutoProof process template you created in Activity 10 to 
the template palette. This is a process template which will automatically 
refine an input file, then automatically output a proof.

Submit a File Via Template Palette for Automatic Refine and Proof

1. Locate a PostScript or PDF input file to test your new automatic workflow —
for example: \\JobData\Task Oriented Activities\Activity 
11\typebrochure.ps

2. Drag the input file to the new template palette. The system will automatically 
refine and then output a virtual proof of the file using the workflow you 
configured in Activity 10. 

3. Open Process Viewer. View the status of the refine and output processes.

4. When the output process is complete, return to the shared HotFolders 
volume to view the preview files in the Refine for AutoProof\Output folder.

Activity Summary
In Activity 11, you added your new process template created in Activity 10 to a 
template palette. This process template will automatically refine and output an 
input file. You can now submit files to this automatic workflow via a hot folder or a 
template palette.

Activity: Apply What You Know

For more information, refer to Prinergy Evo Help: Creating and Configuring Template Palettes. 
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Refine an Imposed PostScript Flat to 
PDF Using OPI

Who Should Complete This Activity
• Applications specialists

• Customer service engineers

• Prinergy Evo users—prepress operators

Recommended Reading
• Prinergy Evo Client Help: How Does Prinergy Evo Handle Font and OPI 

Replacement?

Time to Complete This Activity
Approximately 20 minutes
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Refine an Imposed PostScript Flat to PDF 
Using OPI

What You’ll Learn

• How different Prinergy Evo factory default refine process templates handle 
OPI image references

• How to configure OPI image search options in a refine process template

• How to distinguish flat-based imposition files from page-based imposition 
files

What You’ll Need

For this practice activity, you must: 

• Locate a PostScript imposed flat input file that uses OPI reference to high-
resolution images located elsewhere—for example, 
JobData\[YourName]\Task-Oriented 
Activities\Activity12\ImposedFlat_OPI.PS. 

• Locate high-resolution image files referenced in the PostScript input file—for 
example, JobData\[YourName]\Task-Oriented 
Activities\Activity12\Images.
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1. Locate the imposed PostScript file ImposedFlat_OPI.PS file. 

This file requires Prinergy Evo to interpret OPI comments and place the high-
resolution image files in the refined PDF. Prinergy Evo users should know 
which of their supplied input files will require image replacement.

2. Submit ImposedFlat_OPI.PS to the Prinergy Evo default RefineToPDF-OPI 
process template. 

3. Observe that the refine process fails. Use Item History in the Process Viewer 
to check why the process failed.

4. Start Process Template Editor and open the default RefineToPDF-OPI-Factory 
process template. 

5. Check which options are currently shown in the Normalize area, in the 
Images box. These options determine how Prinergy Evo handles images and 
image replacement.

6. Click Add next to the Search Path Order box. 

This will allow you to select a location where Prinergy Evo will search for 
images referenced by OPI comments contained in input files.

a. Under File menu select Save as

b. Select Process Templates from the drop-down list at the top of the Save 
Process Template window.

c. Select a folder to store the new process template

d. Name the process template i.e., Refine to PDF-OPI-Activity12

7. In the File Browser dialog box, browse to JobData\[YourName]\Task-
Oriented Activities\Activity12\Images. With this folder selected, click 
Select "Images".

Prinergy Evo 1.1 (and later versions) also supports relative image search paths.

8. Save the process template with a new name—for example, 
YourNameActivity12, and then close Process Template Editor.

9. Submit ImposedFlat_OPI.PS to your new YourNameActivity12 process 
template.

Use Item History in the Process Viewer to observe what messages Prinergy 
Evo provides as it processes the file.

Activity: Apply What You Know

If you need more information about OPI image replacement or other graphic arts digital workflows or 
concepts, you may find PocketPal: A Graphic Arts Production Handbook (18th edition or newer) 
helpful. This book is produced by International Paper.
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a. Select View by Process

b. Select ImposedFlat_OPI.ps process

c. Click Item History button (bottom right of View by Process window)

10. When the process is complete go to Activity 12 folder, inspect the new PDF 
file in Acrobat.

Note that the file shows an imposed flat, rather than a single page. This is 
called a flat-based imposition to distinguish this type of imposition file and 
workflow from a page-based imposition file, which uses a PJTF or JDF to link an 
imposition to pages and marks.

You should now see all images that were used in the file. 

Activity Summary
You should now be able to:

• Interpret Process Viewer messages about image replacement

• Modify refine process template options to specify an image search path, so 
Prinergy Evo Normalizer can resolve OPI image references

• Write here or discuss the benefits of an OPI workflow, especially for a flat-
based imposition workflow.

_________________________________________________________

_________________________________________________________
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Personal Notes
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View and Edit Traps in PDF Pages

Who Should Complete This Activity
• Applications specialists

• Prinergy Evo users—prepress operators

Recommended Reading
• PDF Trapper Quick Start Guide 

• Separation Viewer Help

• Prinergy Evo Client Help: Trap Options

• View Accelerator plug-in Help

Time to Complete This Activity
Approximately 60 minutes



Module 13: View and Edit Traps in PDF Pages

84  Activities Guide

View and Edit Traps in PDF Pages

What You’ll Learn

• How to select and view traps using the PDF Trap Editor and Separation Viewer 
plug-in

• How to use View Accelerator plug-in

• How to trap vector objects using the PDF Trap Editor plug-in

• How to trap and edit traps using the PDF Trap Editor options to resolve 
common trapping needs: opaque inks, bitmaps images, rich blacks, and 
double-hits of the same spot color.

What You’ll Need

For this practice activity, you must: 

• Install the PDF Trap Editor plug-in on your Prinergy Evo Client computer

• Install Separation Viewer plug-in on your Prinergy Evo Client computer

• Install Prinergy View Accelerator plug-in on your Prinergy Evo Client 
computer

• Have access to a Prinergy Evo server that is licensed for trapping

• Have access to one of the following online resources:

–  https://ecentral.graphics.kodak.com

–  http://techplanet.creo.com/
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1. Create a refine process template that has trapping enabled. Don’t change the 
default trapping settings. For more information about these settings, refer to 
the context-sensitive online help, or Prinergy Evo Client Help: Trap Options.

Save the refine process template with a unique name—for example, 
YourNameRefineandTrap.

2. Submit PDF input files to the new refine and trap process template. The 
required files are provided in the Task-Oriented Activities\Activity 13 folder:

– NoCurves.pdf

– EditProperties.pdf

– ComplexBitmap.pdf

– OpaqueInks.pdf

– RichBlack.pdf

– DoubleHit.pdf

3. Open the resulting trapped PDF pages in Acrobat and view the traps using the 
PDF Trap Editor plug-in. 

– Compare these trapping results to those achieved by manual trapping 
with the PDF Trap Editor plug-in.

– Experiment with how the View Accelerator and Separation Viewer plug-
ins affect how you can view files in Acrobat.

Activity: Apply What You Know
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Activity Summary
You should now be able to:

• Locate the available documentation resources for trapping and separation 
viewer plug-ins.

• Demonstrate how to view traps using the PDF Trap Editor and Separation 
Viewer plug-ins.

• Demonstrate how to edit traps using the PDF Trap Editor plug-in.

• Demonstrate how to create a refine process template that will trap input files 
using default settings. 

• Compare and contrast using Separation Viewer and Acrobat to inspect PDF 
pages with using Prinergy Virtual Proofing System software. 

• Write here or discuss: 

– What are the required workflow steps in using each software for proofing 
on screen? 

______________________________________________________________

______________________________________________________________

______________________________________________________________

– What are the benefits of using each software for proofing on screen?

______________________________________________________________

______________________________________________________________

______________________________________________________________
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Activity Summary Answers
• What are the required workflow steps in using each software for proofing on 

screen?

– Separation Viewer and Acrobat can be used with any PDF file. 

– Prinergy Virtual Proofing System software will only open .prv preview 
files, which have been output by Prinergy systems.

• What are the benefits of using each software for proofing on screen?

Benefits of Separation Viewer plug-in:

– You can see which spot colors are used in the file, and where they used.

– You can quickly check your PDF file without the additional step of 
outputting preview files. 

Benefits of Prinergy Virtual Proofing System software:

– You can see which spot colors are used in the file, and where they used.

– You can see the result of rendering and screening by Prinergy Evo, which 
is the same processor that will render and output to high-resolution 
devices. 

– You can check that imposition geometry is properly applied.

– You can check that check color separations are correct.

– You can view a low-resolution version of your high-resolution imposition, 
so file sizes are manageable.
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Install a Prinergy Evo System

Who Should Complete This Activity
• Applications specialists

• Customer service engineers

• Optional: Prinergy Evo users—system administrators

Recommended Reading
• Prinergy Evo Installation Guide 

Time to Complete This Activity
Approximately two hours
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Install a Prinergy Evo System

What You’ll Learn

• How to install the Prinergy Evo server and client software

• How to complete the Prinergy Evo on-site installation procedure

What You’ll Need

For this practice activity, you must: 

• Locate the completed Prinergy Evo PreSite Worksheet for the site. 

A sample is provided in the Task-Oriented Activities\Activity 14 folder on 
your Prinergy Evo Training DVD. Complete the worksheet for the training 
environment before proceeding with this activity.

• Download the most recent version of the following documents. PDF versions 
of these documents are provided in the 
\\<machine name>\PgyEvoInstll\doc\<language>\ folder on your Prinergy 
Evo Training DVD

– Prinergy Evo Installation Guide

– Prinergy Evo Installation Checklist
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1. Print the Prinergy Evo Installation Checklist, if required.

2. Plan the installation. Gather required equipment, software, documentation.

3. Ensure that the Prinergy Evo PreSite Worksheet is appropriately completed for 
your site.

– Check that IP addresses of all computers are correctly assigned.

– Check that parameters for output devices, proofing devices, and storage 
devices are correctly recorded.

4. Follow the Prinergy Evo Installation Checklist to complete the system 
installation and configuration.

5. Follow the Prinergy Evo Installation Test Procedure to complete the installation.

6. Back up the system configuration following the procedure in the Prinergy Evo 
Installation Guide. You will use the compressed backup file in another activity.

Activity Summary
You should now be able to install, configure, and test a Prinergy Evo system.

List here any aspect of installation or configuration that you need to practice more 
fully:

•

•

•

•

•

•

Activity: Apply What You Know
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Create and Test a Prinergy Evo Virtual 
Printer

Who Should Complete This Activity
• Prinergy Evo users—system administrators

• Applications specialists

• Optional: customer service engineers

Recommended Reading
• Prinergy Evo Client Help: Creating Virtual Printers

Time to Complete This Activity
Approximately 30 minutes
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Create and Test a Prinergy Evo Virtual Printer

What You’ll Learn 

How to configure a Prinergy Evo refine to PDF virtual printer. You will print to the 
virtual printer from your desktop publishing application (for example, 
QuarkXPress, InDesign)

What You’ll Need

For this practice activity, you must locate source files you can print from a desktop 
application on a client computer—for example, Task-Oriented 
Activities\Activity 15\HearthstoneB.xp4 on your Prinergy Evo Training DVD.
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What Is a Virtual Printer?

A Prinergy Evo virtual printer is a network print queue with a refine to PDF 
process template attached. Virtual printers can be accessed using either a 
AppleTalk or LPR (IP printing) print driver. Use a Prinergy Evo virtual printer to 
automate your input workflow. A Prinergy Evo virtual print driver enables you to 
print your input file directly from your desktop application to Prinergy Evo to 
create a refined PDF file. You can print to a virtual printer from Mac OS X and 
Windows client computers. 

Publish a Prinergy Evo Virtual Printer

1. Read Prinergy Evo Client Help: What Is a Virtual Printer?

2. Determine which type of virtual printer you will use in your Prinergy Evo 
workflow: AppleTalk or LPR. Read the appropriate procedure for your 
environment:

– Prinergy Evo Client Help: How to Publish an AppleTalk Virtual Printer

– Prinergy Evo Client Help: How to Publish an LPR Virtual Printer

3. Start Prinergy Evo. From the Configure menu, select Virtual Printers.

4. Click New.

5. In the New Virtual Printer dialog box, select a refine to PDF process template.

6. In the Name field, type a name for the new refine to PDF virtual printer. Use a 
name which will help users identify the printer from their desktop 
applications. For this exercise, you could name this printer 
Prinergy_Evo_Refine_to_PDF. 

7. Select the type of printer you want to use:

– AppleTalk

– IP Printing (LPR) 

8. Click Set to browse for a folder to save the refined PDF. 

9. Select a folder. The folder location displays in the Default Output Location 
area. Click OK when you have selected the folder where Prinergy Evo should 
send refined PDF files.

10.  In the New Virtual Printer dialog box, click Create. Prinergy Evo creates a new 
print driver that is available to your client computers.

Activity: Apply What You Know

Note: Prinergy Evo Server software must have read, write, and modify privileges on the folder from 
which you submit input files to Prinergy Evo. You can store your input files on the shared JobData 
file server volume on the Prinergy Evo server computer, and access them from a client computer.
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11. Close the Virtual Printer dialog box. 

When you print to this virtual printer, Prinergy Evo will automatically refine 
the file using the process template you selected.

Add the Virtual Printer to Each Client Computer

Next, you need to configure each of your computers to use the new virtual printer 
you created. 

1. For each computer that will submit files to Prinergy Evo via the virtual printer, 
determine:

– What operating system is the computer using (Windows or Mac OS)?

– What network protocol is the computer using to communicate with the 
Prinergy Evo virtual printer (AppleTalk or TCP/IP)?

2. Add the Prinergy Evo virtual printer to the operating system of each computer 
that will submit files to Prinergy Evo via the virtual printer. Choose from the 
following Prinergy Evo Client Help topics and follow the instructions that 
apply to your network and operating system configuration: 

– How to Add an AppleTalk Virtual Printer to a Mac OS

– Add an AppleTalk Virtual Printer to a Windows Server

– Add a LPR IP Virtual Printer to Mac OS X

– Add a LPR IP Virtual Printer to a Windows Computer

Submit Input to Prinergy Evo by Printing to a Virtual Printer 

After you have added the virtual printer to the (client) computer operating 
system, the printer is available to your desktop applications. You can now submit 
input files to Prinergy Evo by printing directly to the new virtual printer from 
applications like QuarkXPress and InDesign.

1. Open a document in a desktop page layout or text-editing application. For 
example, you may use QuarkXPress, InDesign, Microsoft Wordpad, or 
Notepad. 

2. From the File menu in your desktop application, select Print.

3. In the Print dialog box, select the Prinergy Evo virtual printer you created in 
the previous procedure. In some applications, another Printer or Printer 
Properties dialog box will open. 

Select the Prinergy Evo Server IP address or server name. This represents the 
virtual printer you created.You do not need to adjust any other settings. 

4. Click Print. Your file will print to Prinergy Evo. Prinergy Evo will automatically 
refine the file via the process template you associated with the virtual printer. 

5. In Prinergy Evo, open the Process Viewer. You can view the status of your file 
as it is refined.
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Activity Summary
You should now be able to:

• Create a virtual printer in Prinergy Evo that will automatically refine files 
submitted from a supported desktop application.

• Create a virtual printer on each of your computers in order to access the 
Prinergy Evo virtual printer.

• Submit a file to Prinergy Evo for refining to PDF directly from a desktop 
application to the new virtual printer. 
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Correctly Shut Down Prinergy Evo Server

Who Should Complete This Activity
• Applications specialists

• Customer service engineers

• Prinergy Evo users—system administrators

Recommended Reading
• Prinergy Evo Administrator Help: What Is the Prinergy Evo Administrator?

• Prinergy Evo System Administration Guide: Chapter 2, Starting and Stopping 
Prinergy Evo server.

• Prinergy Evo Administrator Help: Reference Overview

Time to Complete This Activity
Approximately 30 to 40 minutes
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Correctly Shut Down Prinergy Evo Server

What You’ll Learn 

• How to navigate Prinergy Evo administrator troubleshooting tools

• How Prinergy Evo runs as a service under Windows Server 2003 operating 
system

• Recommended shutdown and restart procedure for Windows Server 2003 
operating system

What You’ll Need

For this practice activity, you must have a Prinergy Evo server computer running 
and available to shut down and restart.

1. Read Prinergy Evo System Administration Guide: Chapter 2, Starting and Stopping 
Prinergy Evo Server.

2. Write here or discuss how to decide whether to: 

– Stop and restart Prinergy Evo JTPs

– Stop and restart Prinergy Evo server service.

– Shut down and restart the server computer.

___________________________________________________________

___________________________________________________________

3. Read Prinergy Evo System Administration Guide: Chapter 2, Table 5: Detailed 
description of daemons and Table 6: Prinergy Evo system JTPs.

4. Stop and restart Prinergy Evo server software using the recommended 
procedure from the Prinergy Evo System Administration Guide.

Write here or discuss another way you could stop and restart Prinergy Evo 
Server software?

___________________________________________________________

___________________________________________________________

5. Observe and discuss the messages available in the system that appear when 
the Prinergy Evo server software is shutting down and restarting. Use the 
following tools:

– Prinergy Evo Administrator
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– Windows 2003 Event viewer

– Windows 2003 Performance monitor

6. Write here or discuss the best procedure for shutting down (turning off) a 
Prinergy Evo server computer.

___________________________________________________________

___________________________________________________________

___________________________________________________________

___________________________________________________________

Activity Summary
You should now be able to:

• Describe the circumstances in which it is necessary to shut down a Prinergy 
Evo server computer

• Demonstrate the recommended procedure for stopping and starting Prinergy 
Evo

• Describe the system activities that occur when stopping and starting Prinergy 
Evo server 
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Save and Restore a Prinergy Evo Server

Who Should Complete This Activity
• Applications specialists

• Customer service engineers

• Prinergy Evo users—system administrators

Recommended Reading
• Prinergy Evo Administrator Help: How Do I Recover My Prinergy Evo System?

• Prinergy Evo System Administration Guide: Chapter 4, Saving/Restoring Prinergy 
Evo Configuration Settings.

Time to Complete This Activity
Approximately 60 minutes
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Save and Restore a Prinergy Evo Server

What You’ll Learn

How and why to perform each level of Prinergy Evo system reset. 

What You’ll Need

For this practice activity, you must: 

• Have a Prinergy Evo server computer running and available to shut down and 
restart

• Have a saved, compressed backup configuration file from a Prinergy Evo 
system.

1. Read Prinergy Evo Administrator Help: How Do I Recover My Prinergy Evo 
System?

2. Save the configuration of your Prinergy Evo system.

3. Write here or discuss some of the reasons why you might decide it is 
necessary to reset the Prinergy Evo server:

_____________________________________________________________

_____________________________________________________________

_____________________________________________________________

_____________________________________________________________

4. Read Prinergy Evo Administrator Help: How severe should this reset of Prinergy 
Evo be? Write here or discuss how you would decide what severity of reset to 
choose:

_____________________________________________________________

_____________________________________________________________

_____________________________________________________________

_____________________________________________________________

5. Perform a reset on your Prinergy Evo server. 

If you have time, try each level of reset.
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6. Observe the changes in your system after the reset.

_____________________________________________________________

_____________________________________________________________

_____________________________________________________________

7. Restore the backed up configuration settings. 

8. Observe the changes in your system after restoring the backed up 
configuration.

_____________________________________________________________

_____________________________________________________________

_____________________________________________________________

9. Test the restored configuration. Use files which you have already successfully 
processed. For example, you can use the installation test procedure files 
supplied on your Prinergy Evo Training DVD, in the ITP Files folder.

10. Optional: Discuss results with other participants in your training class.

Activity Summary
You should now be able to:

• Save the configuration of your Prinergy Evo system

• Reset a Prinergy Evo system

• Describe circumstances where each level of reset severity is appropriate

• Restore backed up Prinergy Evo system configuration settings
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Create a Prinergy Evo Error Report

Who Should Complete This Activity
• Applications specialists

• Customer service engineers

• Prinergy Evo users—system administrators

Recommended Reading
• Prinergy Evo Administrator Help: Creating Compressed Troubleshooting 

System Log Files

• Prinergy Evo Client Help: Reporting Errors

Time to Complete This Activity
Approximately 15 to 20 minutes
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Create a Prinergy Evo Error Report

What You’ll Need

For this practice activity, you must: 

• Have a Prinergy Evo server running.

• Locate the file for Activity 18.

What You’ll Learn 

• How to create error reports for a specific process
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If Your Using the Prinergy Evo Administrator Software

1. Refine Activity 18.pdf using a factory refine process template, such as Refine 
to PDF - Factory.

2. Observe the messages in the Process Viewer of the Prinergy Evo Client 
software.

3. In the Prinergy Evo Administrator Help, follow the procedure to create a 
compressed file of the system log files.

4. Write here or discuss the recommended procedure you should follow if you 
ever need to send files to Kodak for further support. Depending on your job 
role and geographic location, the path you follow to get help will be different. 

_____________________________________________________________

_____________________________________________________________

_____________________________________________________________

If Your Using the Prinergy Evo Client Software

1. Refine Activity 18.pdf using a factory refine process template, such as Refine 
to PDF - Factory.

2. Observe the messages in the Process Viewer of the Prinergy Evo Client 
software.

3. In the Process Viewer, click the View by Process view, highlight the failed 
process, and then select System > Report Processing Error.

4. In the Problem Description box, type a description of the problem, such as 
The file Activity 18 failed to refine.

5. Click Set and browse to a share that Prinergy Evo can access (for example, the 
JobData share).

6. Click Save, and then click OK.

7. Write here or discuss the recommended procedure you should follow if you 
ever need to send files to Kodak for further support. Depending on your job 
role and geographic location, the path you follow to get help will be different. 

_____________________________________________________________

_____________________________________________________________

_____________________________________________________________

Activity: Apply What You Know
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Activity Summary
You should now be able to:

• Describe the escalation path you will follow for getting help with Prinergy Evo 
problems

• Use Prinergy Administrator and online resources to find troubleshooting 
information on how to generate a Prinergy Evo error report and how to upload 
it to Kodak.

• Create Prinergy Evo system logs
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Update Prinergy Evo Software and Roll Back 
a Software Update

Who Should Complete This Activity
• Applications specialists

• Customer service engineers

• Prinergy Evo users—system administrators

Recommended Reading
• Prinergy Evo Administrator Help: Checking for and Installing Updates Via 

Prinergy Evo Administrator

• Prinergy Evo Administrator Help: Changing the Active Version

Time to Complete This Activity
Approximately 40 to 60 minutes
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Update Prinergy Evo Software and Roll Back a 
Software Update

What You’ll Learn 

• How Prinergy Evo software updates are provided according to support 
contract entitlements

• How to automatically and manually check for available software updates

• How to update a Prinergy Evo system

• How to roll back a Prinergy Evo software update

What You’ll Need

For this practice activity, you must: 

• Have a Prinergy Evo system running

• Have access to https://ecentral.graphics.kodak.com

• Have a software version update available to install
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1. Read Prinergy Evo Administrator Help: Checking for and Installing Updates Via 
Prinergy Evo Administrator.

2. Perform a manual check for updates of the Prinergy Evo server software.

3. If updates are available, install the Prinergy Evo server software update using 
the automated procedure.

If no official updates are available via the Prinergy Evo Administrator update 
mechanism or via the Remote Update Manager, then go to the eCentral portal 
and download an earlier version of Prinergy Evo. Follow the installations 
procedures in the Prinergy Evo Installation Guide. 

4. Observe how the Prinergy Evo server system is configured now:

– Note that each Prinergy Evo software version is installed in a unique 
directory. 

– Note the choices you now have on the Start menu on your Prinergy Evo 
server computer.

5. Write here or discuss how these configurations compare to other workflow 
systems you have installed:

_________________________________________________________

_________________________________________________________

_________________________________________________________

6. Write here or discuss how the software update process compares to other 
workflow systems you have installed:

_________________________________________________________

_________________________________________________________

_________________________________________________________

7. Read the software update “roll back” procedure described in Prinergy Evo 
Administrator Help: Changing the Active Version.

8. Change the active software version back to the previously installed version.

Write here or discuss reasons why this procedure might be required:

_________________________________________________________

_________________________________________________________

_________________________________________________________

Activity: Apply What You Know
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Activity Summary
You should now be able to:

• Describe how Prinergy Evo customers will obtain software updates

• Update Prinergy Evo server software

• Change the active version of Prinergy Evo to a previous version

• Describe how Prinergy Evo uses Windows Registry settings and configuration 
files

• Compare and contrast Prinergy Evo update procedures, system recovery 
procedures, and system configurations to those of other workflow systems
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Apply Preps Variable Text Marks

Who Should Complete This Activity
• Applications specialists

• Prinergy Evo users—prepress operators

Recommended Reading
• Prinergy Evo Client Help: Variable Marks and Preps Job Tickets

• Prinergy Evo Client Help: Tell Me More About Variable Marks

• Preps User Guide

Time to Complete This Activity
Approximately 20 to 40 minutes



Activity  20: Apply Preps Variable Text Marks

120 Activities Guide 

Apply Preps Variable Text Marks

What You’ll Learn

• How variable text marks work in Preps and Prinergy Evo

• How to find more information about working with Preps and Prinergy Evo.

What You’ll Need

For this practice activity, you must: 

• Locate input files to impose in Preps. Use files in the Task-Oriented 
Activities\Activity 20 folder

• Have Preps 5.2 (or later) installed

• Make sure the required Preps templates has been copied to the 
Preps\Templates folder on your client computer. For this activity, check that 
the following template is installed: 
Task-Oriented Activities\ITP Files\Impositions\Preps Templates\ITP-
Templates 

• Make sure your Prinergy Evo system has an output from imposition process 
template configured to create Prinergy Virtual Proofing System software 
preview files
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1. Read Prinergy Evo Client Help: Variable Marks and Imposition Job Tickets. This 
will introduce variable marks and how Preps and Prinergy Evo use them.

2. Create a new Preps PDF to PDF job. 

3. Refine input files. Use files in the Task-Oriented Activities\Activity 20 folder.

4. Add refined PDF pages to the new Preps job. 

5. Assign a template and select signatures. Use the Prinergy Evo ITP template: 
ITP-Templates and the 8page signature.

6. Open the template and view the marks used on the signature you have 
selected. You will see variable marks that include these variables:

$[date] $[time] $[color] $[process template name] 

7. Read Prinergy Evo Client Help: Tell Me More About Variable Marks. 

8. Print the Preps job as a PJTF imposition file using Device: Press Sheet Size. 

Note that Preps will only generate a PJTF file. If this were a Mixed to 
PostScript Preps job, Preps would generate an additional marks.pdf file. 

For more information about submitting Preps imposition files to Prinergy Evo, 
review Prinergy Evo Client Help: Submitting Preps Files. 

9. Save the Preps job. You will use this job in a later learning activity. Save the 
Preps job in your JobData\Your_Name\Activity 20 folder.

10. Submit the PJTF imposition file to Prinergy Evo for output processing to proof 
as Prinergy Virtual Proofing System software preview files. 

11. Track the progress of your process in the Process Viewer in Prinergy Evo.

12.  Open the Prinergy Virtual Proofing System software preview files generated 
by Prinergy Evo. 

Look for the text marks used on each separation. Observe that Prinergy Evo 
has replaced the text variables with specific information about the files.

Activity Summary
You should now be able to:

• Demonstrate how to use Preps variable text marks in a PDF workflow

• Locate more information about working with Preps and Prinergy Evo

Activity: Apply What You Know
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Troubleshoot a Common Imposition 
Workflow Error

Who Should Complete This Activity
• Applications specialists

• Prinergy Evo users—prepress operators

Recommended Reading
One of the following online resources:

• http://techplanet.creo.com/ -> Prinergy Evo -> Troubleshooting page.

• https://ecentral.graphics.kodak.com -> Prinergy Evo -> Self Support pages.

Time to Complete This Activity
Approximately 20 to 40 minutes

http://techplanet.creo.com
https://ecentral.creo.com/
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Troubleshoot a Common Imposition 
Workflow Error

What You’ll Learn

The recommended procedure for re-submitting an imposition for output when the 
imposition has been submitted to Prinergy Evo and the PDF digital master page 
files have been moved.

After having already submitted an imposition for output in Prinergy Evo, you may 
sometimes find it necessary to move your PDF digital master page files to a new 
location, or to rename folders that organize the files on the Prinergy Evo server. 

In this activity, you will explore what happens when you attempt to submit an 
imposition file to output process after changing the folder structure in which the 
files were originally organized.

What You’ll Need

For this practice activity, you must: 

• Locate a Preps job that has already been output to Prinergy Virtual Proofing 
System software preview files. You may use the Preps job created in Activity 
20. Locate the PJTF imposition file and the digital master (refined) PDF files in 
the JobData\Your_Name\Activity 20 folder.

• Make sure your Prinergy Evo system has an output from imposition to virtual 
proof process template. Create one now, if necessary.

• Make sure your Prinergy Evo system has a hot folder connected to an output 
from imposition to virtual proof process template. Create one now, if 
necessary.
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1. Locate a PJTF you have already submitted to Prinergy Evo—for example, 
JobData\Your_Name\Activity 20\[YourInitials].PJTF.

2. Create a new folder called JobData\Your_Name\Activity 21.

3. Move your refined PDF files (digital masters) from 
JobData\Your_Name\Activity 20 to your new \Activity 21 folder. Do not 
move any other file.

4. Submit the PJTF for output via the Template Browser. 

Write here or discuss with other students what happens:

_____________________________________________________________

_____________________________________________________________

Write here or discuss with other students what you think you need to do to 
resolve the problem:

_____________________________________________________________

_____________________________________________________________

5. Submit the PJTF for output via hot folder for imposed output to Prinergy 
Virtual Proofing System software preview files.

Write here or discuss with other students what happens:

_____________________________________________________________

_____________________________________________________________

6. Review online troubleshooting resources for possible solutions to this 
problem.

Write here or discuss with other students what you think you need to do to 
resolve the problem:

_____________________________________________________________

_____________________________________________________________

7. Correct the problem and submit the PJTF again:

a. Move the PJTF to the same location as the PDF digital master files: 
JobData\Your_Name\Activity 21.

b. Drag the PJTF imposition file to an output process template icon in the 
Template Browser. The output Process Start dialog box should appear and 
the file should process normally.

Activity: Apply What You Know
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8. Submit the same PJTF imposition file to the process template via a hot folder 
again. 

Write here or discuss with other students what happens:

____________________________________________________________

_____________________________________________________________

9. Review online troubleshooting pages for possible solutions to this problem.

Write here or discuss with other students what you think you need to do in 
order to be able to submit the file via a hot folder:

_____________________________________________________________

_____________________________________________________________

Optional Additional Practice:

Experiment with what happens if you repeat the activity using a JDF imposition 
file rather than a PJTF. 

Activity Summary
You should now be able to: 

• Explain best practices in managing input files to allow for re-submitting an 
imposition file to Prinergy Evo

• Compare and contrast imposition file submission channels



Troubleshoot a Common Imposition Workflow Error

Prinergy Evo    127

Personal Notes



Module 21: Troubleshoot a Common Imposition Workflow Error

128  Activities Guide



Prinergy Evo     129

A
CT

IV
IT

Y
Auto-Resolve Spot Color Naming Conflicts

Who Should Complete This Activity
• Applications specialists

• Prinergy Evo users—prepress operators

Recommended Reading
• Prinergy Evo Client Help: Spot Color Handling Options

• Prinergy Evo Client Help: Auto-Resolve Spot Color Naming Conflicts

Time to Complete This Activity
Approximately 10 to 20 minutes
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Auto-Resolve Spot Color Naming Conflicts

What You’ll Learn

• Spot color handling options in Prinergy Evo process templates.

• How to use the Auto-Resolve Spot Color Naming Conflicts feature in the 
refine process template: 

The different software programs used in the prepress/print industries use 
different naming conventions (using CV, CVC, and CVU endings with the file 
names) for identical PANTONE spot colors. Consequently, a user whose page 
files were created in different programs could find at least two different names for 
the same PANTONE color used in a single print job. 

Prinergy Evo has a feature that automatically renames identical PANTONE spot 
color names with different endings (CV, CVC, and CVU) so that the colors remain 
on the same separation. For example, PANTONE 871 CV, PANTONE 871 CVC, and 
PANTONE 871 CVU would all be renamed to PANTONE 871 C.

What You’ll Need

For this practice activity, you must locate input files in Task-Oriented 
Activities\Activity 22.
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1. Locate the supplied input file in \\Task-Oriented Activities\Activity 22. 

2. To determine which spot colors are used in these files, refine the file using the 
Activity 22 Refine process template. 

3. Write here the PANTONE color names used in the files that are identical, 
except for the CV or CVC suffix:

______________________________    ____________________________

4. Open the Refine to PDF - Factory process template.

5. In the Refine process template dialog box, put a check mark in the Spot Color 
Handling box. Check which spot color handling options are currently 
selected.

6. In the Spot Color Handling area of the process template, select Do Not Map 
Spot Colors and Auto-Resolve Spot Color Naming Conflicts.

7. Save the refine process template with a new name—for example, 
YourName_SpotColorsAutoResolve. 

8. Submit the PDF file to the refine process template created in the previous 
step. 

9. Track the refine process in the Process Viewer. Observe what messages you 
can see about spot color handling. 

10.  When the refine process is complete, open the new PDF file and view in  
Acrobat. Note what PANTONE color names are now used in the files.

Activity Summary
You should now be able to adjust refine process template settings to take 
advantage of Prinergy Evo’s ability to automatically resolve common spot color 
naming conflicts.

Activity: Apply What You Know

Use the context-specific online help to learn more about each of the available options.
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Spot Color Mapping with User Libraries

Who Should Complete This Activity
• Applications specialists

• Prinergy Evo users—prepress operators

Recommended Reading
Read these selections before proceeding:

• Prinergy Evo Client Help: Working With the Color Database Editor

• Prinergy Evo Client Help: Creating Your Own Color Library

• Prinergy Evo Client Help: Copying Spot Colors from A File to A Color Library

Time to Complete This Activity
Approximately 15 to 30 minutes
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Spot Color Mapping with User Libraries

What You’ll Learn

• How Prinergy Evo loads the factory-default color library

• How to create a new color library and add custom spot color definitions

• How to covert a spot color job to process using a user-defined color library

Most Prinergy Evo users will be able to use the factory color libraries that are 
installed with the system. If you only use standard PANTONE colors, use the 
factory color libraries. The standard definitions for spot colors contained in these 
libraries will consistently and automatically convert the spot colors defined 
in supplied input files.

Create your own user library if you require a definition for a spot color that is not a 
standard PANTONE color definition. This may be because you want to change the 
process build of a PANTONE color defined in an input file, or because your input 
files contain unique spot color names that are not in the PANTONE database.

What You’ll Need

For this practice activity, you must: 

• Locate Task-Oriented Activities\Activity 23\SpotColors.ps. This file uses 
several spot colors. 
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Create a Refine Process Template That Converts Spot Colors to Process

1. Open the Activity 23 Refine process template. 

2. In the Refine process template dialog box, select Spot Color Handling. Check 
which spot color handling options are currently selected.

3. In the Spot Color Handling area, select Map all Spot Colors to Process. 

4. Select the Resolve Ambiguous Spot Color Definitions check box.

5. Save the refine process template with a new name—for example, 
YourName_ConverttoProcess. 

Create a New Spot Color Library and Add Colors

In this procedure, you will configure a new color library and add some colors to 
that library.

1. From the Configure menu, select Color Definitions.

2. Click Add.

3. In the New User Library dialog box, Library Name box, type a name for your 
color library—for example, YourNameTrainingColors.

4. In the Library Color Space section, select CMYK.

5. Click Add.

6. In the Colors section, click Add. 

7. In the New Color dialog box, in the Color name box, type the color name:

PANTONE 118 CVU 

This is one of the colors used in the input file supplied for this practice activity.

8. Click Add. 

9. In the Alternate Color dialog box, enter the color recipe using either the value 
slide bar or by typing the values in the color boxes. For this activity, you may 
use any recipe. A customer user would define the color recipe used as the 
standard in their company workflow. 

10. Click Apply. The color recipe is saved and in the Colors list, a color swatch 
appears beside the color name.

11. Repeat step #5 through step #9 to add PANTONE 130 CV to the library.

12. Close the Color Definitions window.

Activity: Apply What You Know
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Convert Spot Colors to Process During the Refine Process

1. Submit Task-Oriented Activities\Activity 23\Creotivity.ps to refine via the 
YourName_ConverttoProcess refine process template you created earlier in 
this activity. 

2. Track the refine process in the Process Viewer. Observe what messages you 
can see about spot color handling. Prinergy Evo should convert the colors to 
process, using the color recipes you defined in your color library. 

3.  When the refine process is complete, open the refined PDF files and view in  
Acrobat. Note what PANTONE colors are now used in the files. 

__________________________________________________________

Activity Summary
You should now be able to:

• Describe why a user would create a user library of spot colors

• Demonstrate two methods for adding spot colors to a user library

• Describe the rules Prinergy Evo follows to select the source of a spot color 
recipe

• Convert spot colors to process using the options in a refine process template

For more information about how Prinergy Evo selects the recipe to convert a spot color to process, 
read Prinergy Evo Client Help: Spot Color Handling Options, Source of Spot Color Recipe.
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Editing PDF Page Geometry in Acrobat

Who Should Complete This Activity
• Applications specialists

• Prinergy Evo users—prepress operators

Recommended Reading
• Kodak Prinergy Geometry Editor Plug-in Help

• Prinergy Evo Client Help: Setting Page Geometry

Time to Complete This Activity
Approximately 15 minutes
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Editing PDF Page Geometry in Acrobat

What You’ll Learn

How to set trim box and bleed box for supplied PDF using the Geometry Editor 
plug-in

What You’ll Need

For this practice activity, you must: 

• Install the Geometry Editor plug-in 

• Locate sample input files in the Task-Oriented Activities\Activity 24 folder
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Edit Page Geometry

For details about how to use the Geometry Editor, see the Geometry Editor Help.

1. Open the st001.pdf file in Acrobat.

2. With the refined st001.pdf displayed in Acrobat, click the Geometry Editor 
button on the toolbar.

3. Use the mouse to set the trim box of st001.pdf to make the crop marks visible 
on the page.

4. Use the mouse to set the bleed box so that the bleed marks are visible on the 
page. 

5. Check the Apply to check box in the Geometry Editor if it is not already 
checked.

6. Select the Multiple files check box. Browse to and select the PDF file 
representing odd-numbered pages (that is, st003.pdf, st005.pdf, st007.pdf)

7. Click Apply, and then click Close.

8. In Acrobat, save and close the st001.pdf file.

9. Using the same procedure outlined in steps 1–8, revise the trim and bleed 
boxes for the even-numbered pages.

10. Open a few even- and odd-numbered pages to view the changes made with 
the Geometry Editor.

Activity Summary
You should now be able to:

• Navigate tools available in the Geometry Editor plug-in

• Use the Geometry Editor to set page trim and bleed boxes on a PDF page.

Activity: Apply What You Know
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Creating Relative File Paths

Who Should Complete This Activity
• Applications specialists

• Customer service engineers

• Prinergy Evo users—system administrators

Recommended Reading
• Technical procedure: Suggested Prinergy Evo Job Folder Organization Using 

Relative Paths, available at http://techplanet.creo.com/ on the 
Prinergy Evo (version number) -> Procedures page

• Prinergy Evo System Administration Guide: Chapter 6, Recommended Prinergy 
Evo Client/Server System Folders Settings

• Prinergy Evo Client Help: Tell Me More About Using Relative File Paths

Time to Complete This Activity
Approximately 20 to 30 minutes

http://techplanet.creo.com/
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Creating Relative File Paths

Who Should Complete This Activity

What You’ll Learn

• Recommended practices for folder names and organizing files in a Prinergy 
Evo production environment

• How to use the Prinergy Evo relative paths feature to organize refined PDF 
files within a job folder

• How to configure relative image search paths using settings in the refine 
process template

What You’ll Need

For this practice activity, you must: 

• Have access to one of the following online resources:

– https://ecentral.graphics.kodak.com 

– http://techplanet.creo.com/

• Locate image files, input files, application source files, and font files in the 
Task-Oriented Activities\Activity 25\ Customer Supplied folder. This folder 
contains files like those a Prinergy Evo user might receive from a customer. 
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Organize Job Folders and Supplied files 

1. Read the recommended technical procedure: Suggested Prinergy Evo Job Folder 
Organization Using Relative Paths.

2. Watch the Flash-based online demonstration titled “Using Input Relative 
Output Paths” in the Prinergy Evo Help. To view the help:

1. In the Process Viewer, select Help > Prinergy Evo Help.

2. In the online help, click Index.

3. In the keyword box, type tutorials.

4. In the list of entries below, click tutorials.

3. Create a new job folder on the shared JobData file server volume. 

If you are working in a production environment, use a naming convention that 
makes sense in your workflow. If you are working in a training environment, 
name your job like this:

JobData\YourInitials_0029

4. Read Chapter Six, Recommended Prinergy Evo Client/Server System Folders 
Settings in the Prinergy Evo System Administration Guide.

Create sub-folders within your job folder to organize the files you have 
received in your Task-Oriented Activities\Activity 25\Customer Supplied 
folder. Assign folder names that will suit the files supplied with most of your 
job types.

Creating standard folder names can help you automate your Prinergy Evo 
workflow. 

For this activity, you have been supplied the following file types:

– Images

– Application source files

– PostScript files created from the application source files

– High-resolution images

5. Move your Task-Oriented Activities\Activity 25\Customer Supplied files 
into the new folders. 

Configure a Refine Process Template to Use Relative File Paths

1. Read Prinergy Evo Client Help: Tell Me More About Using Relative File Paths. 

In the next steps, you will use this information to create a process template 
that uses relative paths to search for images and to output refined PDF files. 

Activity: Apply What You Know
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2. Open a refine to PDF process template and save it with a new name—for 
example, YourInitials_RefineOPI.

3. In the new YourInitials_RefineOPI process template, in the Processed File 
Preferences section, type a relative path that will:

a. Create a new folder named Refined PDF Masters in each 
JobData\[jobname] folder.

b. Send processed PDF files to the new Refined PDF Masters folder. 

4. In the new YourInitials_RefineOPI process template, in the Normalize 
section, Search Path Order (from top to bottom) box, type a relative file path 
that will:

a. Search for high-resolution images in a folder that has the same name in 
each job that uses this process template.

b. Correctly locate the high-resolution images for your 
JobData\YourInitials_0029 job.

5. Save the YourInitials_RefineOPI process template.

6. Add this process template to a template palette.

7. Submit the supplied PostScript input files to the new process template.

8. Track the process in Process Viewer.

Activity Summary
You should now be able to:

• Configure relative file paths for OPI image replacement

• Configure relative file paths for Prinergy Evo processed file output

Describe benefits of relative file paths to help organize files in a Prinergy Evo 
production environment
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Configure Preflight Profiles and Submit 
Input File

Who Should Complete This Activity
Prinergy Evo users

Recommended Reading
• Prinergy Evo Client Help: Tell Me More About PDF PreFlight

Time to Complete This Activity
Approximately 30 minutes
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Configure Preflight Profiles and Submit Input 
File

What You’ll Learn

• How Prinergy Evo preflight profiles can identify and fix potential problems 
with supplied input files

• How to edit preflight profile settings

• How to submit files for preflight via process templates in the Template 
Browser feature

• How to use preflight reports to view potential and fixed problems with 
supplied files

What You’ll Need

For this practice activity, you must: 

• Have an installed and configured Prinergy Evo system (version 1.2 or later), 
licensed for Advanced PDF Preflight

• Have Prinergy Evo plug-ins to Acrobat software installed

• Locate sample input files or refined digital master PDF files. You may use the 
\ITP Files\Input Files\EvoITP_Fat.ps file supplied on your Prinergy Evo 
Installation DVD. These files are also provided on the Prinergy Evo Training 
DVD. 
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Use Prinergy Evo Client Help to Learn About Prinergy Evo PDF Preflight 
Profiles

1. Start Prinergy Evo Client software. From the Configure menu, select Preflight 
Profiles. 

2. In Preflight Profile Manager, click Help.

In the Help window, click Show to display concepts, procedures, and options 
for preflight features.

3. Read the following help topics before proceeding:

– Understanding PDF Preflight

– Using PDF Preflight

Create Prinergy Evo PDF Preflight Profiles

1. In Preflight Profile Manager, you can see the default preflight profiles 
installed with the system. Select the Prinergy Defaults profile and click Edit.

2. Save the preflight profile with a new name so you do not change the default 
profile settings.

3. In the new preflight profile, select the Image category.

4. Select the Resolution subcategory, and then choose the following options in 
the Detect area:

a. Select Resolution of color or grayscale image is above, and type 300 
dpi. 

b. From the Report menu, select Warning. 

Prinergy Evo will now report a warning when this preflight profile is used 
to process any files containing images with resolution above 300 dpi.

5. Click Compression, and then choose the following options in the Detect area:

a. Select Color or Grayscale Images, and then in the list of compression 
types select JPEG compressed, LZW compressed, and Not 
Compressed.

b. From the Report menu, select Warning.

c. Select Fix: Compress With, and then select ZIP.

Activity: Apply What You Know

Note: Prinergy Evo only uses preflight profiles created within a Prinergy system. While it is possible 
to import and export profiles between Prinergy systems, it is not possible to import profiles created 
in other workflow systems.
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Prinergy Evo will now report a warning when this preflight profile is used 
to process any images that are compressed with any of the selected 
compression types. Prinergy Evo will compress each of those images 
using ZIP compression. 

6. Select the Text and Line-Art category, and then select the Text and Line-Art 
subcategory.

7.  In the Detect area, choose the following options:

a. Select Text is smaller than, and type 14 points in the box.

b. From the Report menu, select Information.

Prinergy Evo will now report an information message when this preflight 
profile is used to process any files containing text that is smaller than 14 
points. This feature is most useful to warn about very small text, usually 6 
points or smaller. 

8. Do not change any other default settings in the preflight profile.

9. Save the preflight profile.

Apply the New Preflight Profile in a Refine Process Template 

1. Start Prinergy Evo process template Editor. 

2. Open the default RefinetoPDF process template. 

3. Save the process template with a new name—for example, RefinePreflight. 

4. Select and expand PDF Preflight section. 

5. Select Advanced. The standard preflight options will now be unavailable. This 
option is available only on systems that are licensed for Advanced PDF 
Preflight.

6. In the Advanced Preflight section, choose the following options:

a. In the Preflight Profile list, select the new profile you created in the 
previous procedure.

b. In the Preflight Handling section, in the Errors list, select Warn on 
Warnings.

c. In the Report area, select Create One Report per Input File.

7. In the File Delivery section of the process template, set the Processed Files 
Location to your desired location for completed files. 

8. Save and close the process template.

Refine an Input File Using the New Process Template

1. Locate a sample file on a shared file server volume—for example, ITP 
Files\Input Files\EvoITP_Fat.ps. This file is supplied on your Prinergy Evo 
Installation DVD.

2. From the Process Viewer Window menu, select Template Browser. 

Use context-sensitive online help to learn more about the Template Browser.
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3. In the Template Browser, locate the new refine process template you created 
in the previous procedure.

4. Drag your input file to the new refine process template.

5. Monitor processing in Process Viewer. Observe what information about 
preflight appears in the Item History for this process.

Review the Preflight Report for Each Refined Page

1. Locate your refined PDF files. In the same location as those files, locate a 
PreflightReports folder created by Prinergy Evo.

2. Prinergy Evo creates a preflight report for each page in the input file. Open the 
first report—for example, EvoITP_Fat.p0001_rep.pdf.

3. Review the preflight report:

a. Use PDF bookmarks to see warnings and information related to each 
subcategory used in your preflight profile. 

b. Click in the preflight report to view the elements of your refined file 

that the preflight profile settings affected. 

c. Click Go to Report in the Kodak Preflight Locator window to continue 
reviewing your preflight report.

Activity Summary
You should now be able to write here or discuss responses to the following: 

1. What settings will be most helpful in preflight profiles used in your own 
working environment?

_________________________________________________________

_________________________________________________________

2. Who in your working environment will review preflight reports?

_________________________________________________________

_________________________________________________________

3. What are the benefits and limitations of PDF preflight for your working 
environment? 
_________________________________________________________

_________________________________________________________



Module 26: Configure Preflight Profiles and Submit Input File

154  Activities Guide

Personal Notes



Prinergy Evo     155

A
CT

IV
IT

Y
Create a Layout Using Output PDF 
Process Template Settings

Who Should Complete This Activity
Prinergy Evo users

Recommended Reading
• Prinergy Evo Client Help: Output PDF—Layout Options

Time to Complete This Activity
Approximately 25 minutes
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Create a Layout Using Output PDF Process 
Template Settings

What You’ll Learn

How to use the layout settings available in an output PDF process template to 
arrange PDF digital master files in a simple 4-up layout suitable for submitting to 
proof, film, or plate

What You’ll Need

For this practice activity, you must: 

• Have an installed and configured Prinergy Evo system, licensed for output to 
PDF

• Locate sample input files, or refined digital master PDF files. You may use the 
\ITP Files\Input Files\EvoITP_Fat.ps file supplied on your Prinergy Evo 
Installation DVD. These files are also provided on the Prinergy Evo Training 
DVD. 
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Create a Layout Using Output PDF Process Template Options

The options provided in Prinergy Evo output PDF process templates allow you to 
create layouts suitable for output to proof, film, or plate devices. The settings 
allow you to specify the number of pages per surface, to position the pages 
relative to one another, to set bleed margins between pages, and to accurately 
position the entire layout relative to the media. In effect, these settings allow you 
to create simple imposition layouts without using an imposition program. 

1. In Prinergy Evo process template Editor, select the default OutputPDF-VPS-
Factory process template that was installed with the system. Open the 
process template and save it with a new name.

2. From the Output To list, select PDF (Vector Output).

3. Select and expand the Layout section in the new process template. 

4. In the Layout section, set the following options in the Media to set the size of 
your final output media (proofing media, film, or plate). 

a. In the Size list, select Cut Sheet.

b. In the Max Width area, type 25 inch or 625 mm. 

c. In the Max Height area, type 28 inch or 700 mm.

Activity: Apply What You Know
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5. In the Layout section, set options in the Page Placement area to determine 
how your PDF digital master files will be arranged relative to one another. 
Your printing and finishing requirements should inform the options you select 
in this area. For this activity, select the following options:

a. Next to Type, select Top Left to Bottom Right. 

b. Next to Style, select N-Up. 

c. In the Number of Pages Across box, type 2, and in the Down box, type 2. 

d. Clear the Auto Distribute Vertically, Auto Distribute Horizontally, and 
Reduce Gutters if Required boxes.

e. Set Vertical Gutter Width to 1 inch or 25 mm. This will allow you to see 
bleeds and marks included in PDF digital master files.

f.  Set Horizontal Gutter Height to 1 inch or 25 mm. Figure 30.1 illustrates 
gutter settings:

Figure 30.1 Gutter settings 
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6. In the Layout section, set options in the Layout Placement area to determine 
how your layout will be aligned and placed relative to the selected imaging 
media. Your printing and finishing requirements should inform the options 
you select in this area. For this activity, select the following options:

a. In the Align Horizontally list, select Center.

b. In the Vertically list, select Bottom. 

These settings place your layout centered along the bottom or punch 
edge of a plate or film flat. Figure 30.2 shows how the alignment settings 
position your layout relative to the media area.

.
Figure 30.2: Layout Placement alignment settings
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d. Set Shift Vertically to 1 inch or 25 mm to allow space for plate bend. 

You can change these settings to accommodate the production requirements 
of particular devices and printing presses in your working environment.

Figure 30.3 shows how Shift Along settings position your layout relative to 
the media area.

 

Figure 30.3: Layout Placement Shift settings

e. Do not change other Layout Placement default settings.

7. In the Layout section, in the Scaling area, clear all settings. These settings 
may be suitable for some proofing output, but are not suitable for final output 
to film or plate.

8. In the Layout section, in the Marks area, set margins to control the area of the 
media beyond the limits of page trim size. This allows space for marks to print 
between the layout and the edge of the print sheet. For this activity, complete 
the Extra Margins for Marks and Bleed boxes as follows:

a. Left: 0 inch or 0 mm

b. Right: 0 inch or 0 mm

c. Top: 3 inch or 75 mm

d. Bottom: 0 inch or 0 mm 
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9. Place a sheet mark at the top of the layout by selecting the following options 
in the Marks area:

a.  Next to Sheet Marks, click Browse and locate one of your company’s 
production marks. 

Alternatively, browse to the following default mark on your Prinergy Evo 
server computer: [PgyEvoConfig]\MarkSets\Sheet Marks\Color 
Proofers\Separated Proofs\SheetMark-Color-Sep.pdf. 

b. Select the mark and click Open.

c. In the Locate Sheet Marks Adjacent to lists, select Top.

d. In the at a Distance of list, type 0.5 inch or 10 mm.

e. Do not change other Marks area default settings.

10. Set the Processed Files Location to your desired location for completed files. 

11. Save and close the process template.

You can now use this process template to automatically lay out and output 
groups of PDF digital master files. This will allow you to streamline the 
production of jobs that have simple imposition requirements. 

Output PDF Using Layout Settings

1. Refine input files to PDF digital master files that are ready for proof or final 
output. You may use the \ITP Files\Input Files\EvoITP_Fat.ps file supplied 
on your Prinergy Evo Installation DVD. These files are also provided on the 
Prinergy Evo Training DVD. 

2. From the Process Viewer Window menu, select Template Browser. 

3. In the Template Browser, locate the new process template created in the 
previous procedure.

4. Locate your PDF digital master files. Drag the files to the new output PDF 
process template in the Template Browser. 

5. Monitor processing in Process Viewer. When the process is finished, locate 
your completed files.

Prinergy Evo has used the settings in the Layout section of the output PDF 
process template to create one PDF flat file for each four-page surface. You 
can now submit these PDF flat files to a suitable 4-up output device, including 
a proofer, Kodak Trendsetter® platesetter, or filmsetter. 

If you used the supplied files, your output files will be named:

EvoITP_Fat.1A.PDF

EvoITP_Fat.1B.PDF

EvoITP_Fat.2A.PDF

EvoITP_Fat.2B.PDF

6. Open and view the plate-ready PDF flat files in Acrobat.
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Activity Summary
You should now be able to write here or discuss answers to the following: 

1. Write here or discuss which of your jobs could make use of settings in the 
Layout section of an output PDF process template to create a simple layout. 

_______________________________________________________________

_______________________________________________________________

_______________________________________________________________

2. Write here or discuss what information you require about your company’s 
press and finishing requirements in order to correctly complete the following 
settings: 

a. The Page Placement options in the Layout section of the output PDF 
process template

_______________________________________________________________

_______________________________________________________________

b. The Layout Placement options in the Layout section of the output PDF 
process template

_______________________________________________________________

_______________________________________________________________
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Personal Notes
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Automatically Create Impositions

Who Should Complete This Activity
Prinergy Evo users

Recommended Reading
• Prinergy Evo Administrator Help: License Manager

• Prinergy Evo Client Help: About Creating Imposition Plans in Prinergy Evo

• Prinergy Evo Client Help: Outputting Automatic Imposition Plans

• Preps 5.0 (or later) User Guide 

Time to Complete This Activity
Approximately 40 minutes
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Automatically Create Impositions

What You’ll Learn

• How to configure a create imposition process template that uses an existing 
imposition layout template created in Preps.

• How to use the new create imposition process template to automatically 
assign PDF digital master files and create a populated JDF imposition file 
without using Preps software.

What You’ll Need

For this practice activity, you must: 

• Have an installed and configured Prinergy Evo system (version 1.2 or later), 
licensed to automatically create imposition files

• Have a licensed copy of Preps (version 4.2 or later)

• Locate a four-page Preps template—for example,  
\ITP\Impositions\PrepsTemplates\ITP-4up on your Prinergy Evo 
Installation DVD

• Locate sample PDF digital master files. You may use the 
\ITP\PreRefinedPages\ EvoITP_Fat.p0001.pdf through 
EvoITP_Fat.p0016.pdf supplied on your Prinergy Evo Installation DVD.
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Kodak has introduced to Prinergy Evo a licensed feature that enables users to 
automatically create populated JDF imposition files without starting Preps or any 
other imposition software. 

In an automatic imposition workflow, users submit PDF digital master files to a 
create imposition process template. The create imposition process template 
automatically imposes the pages, using an existing Preps template and signature 
specified. Prinergy Evo creates a populated JDF imposition file, which can then be 
output via any imposition output process template. 

Prepare Prinergy Evo and Preps to Work Together 

Before you use the Prinergy Evo create imposition process templates, you must 
confirm that Prinergy Evo Server software and Preps software are configured to 
correctly share the required resources. Complete this procedure to prepare 
Prinergy Evo and Preps to work together to automatically create imposition plans. 

1. Choose a central location for your Preps templates, marks, and printers that 
each of your users and Prinergy Evo Client computers can access via your 
network. The default location for these files is a folder on a shared file server 
volume on your Prinergy server computer: 
[PrinergyServerName]\PgyEvoConfig\Preps.

2. Move your existing Preps Templates, Marks, and Printers folders from your 
client computer to the shared folder you chose in step 1. 

3. Start Preps imposition software to check what information Prinergy Evo will 
use for automatic imposition:

a. Open the Installation Test Procedure ITP-4up template, and note that this 
template contains only one signature. Though Preps supports multiple 
signatures in a single template, Kodak recommends that the templates 
you use for automatic imposition contain only a single signature.

b. Select the signature. From the Preps Edit menu, select Get Information. 

c. In the Signature Information dialog box, ensure that Make Signature 
Available for AutoSelect is selected. Only template signatures with this 
option enabled can be used by Prinergy Evo for automatic imposition. 

d. Close the template and quit Preps.

Configure a Prinergy Evo Create Imposition Process Template

1. Start Prinergy Evo process template Editor.

2. Expand the Create Imposition group (found under Factory Templates), and 
then select and open one of the default process templates. 

3. Save the create imposition process template with a new name. 

Activity: Apply What You Know
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4. Expand the Preps Imposition Planning section of the process template. In this 
section, you will select a Preps template and print device settings for Prinergy 
Evo to use when automatically creating an imposition layout. 

5. In the Template area, select the following options to tell Prinergy Evo which 
Preps template to use from the \Preps\Templates folder on your shared file 
server volume:

a. In the Binding Style list, select Perfect Bound.

b. In the Template Name list, select ITP-4up. If this template is not available, 
check your steps in the procedure Prepare Prinergy Evo and Preps to Work 
Together on page 15, or select another template.

6. In the Device area, in the Installed Device list, select Press Sheet Size. 

The Press Sheet Size device installed by default in Preps will be suitable for 
most output to Prinergy Evo. 

7. In the Profile Settings area, select Auto Reverse Backward Page and Auto 
Center Runlist Pages. Settings in this area determine how Prinergy Evo will 
control the PDF digital master files as it places them in the imposition 
template. 

8. Set the Processed Files Location to your desired location for completed 
imposition files. 

 9. Save and close the new process template.

Submit Single-Page PDF Digital Master Files for Automatic Imposition

You can now use your new create imposition process template to automatically 
impose PDF digital master files by selecting files and submitting them for 
processing via the new process template. When you select your PDF files, you will 
be able to arrange the files in a run list order. Prinergy Evo will automatically 
impose the files using the Preps template specified in the create imposition 
process template. 

1. Locate sample PDF digital master files. You may use the 
\ITP\PreRefinedPages\ EvoITP_Fat.p0001.pdf through 
EvoITP_Fat.p0016.pdf supplied on your Prinergy Evo Installation DVD.

2. Open the Prinergy Evo Template Browser, and then drag the PDF files to the 
create imposition process template you configured in the previous procedure.

Click for more information from context-sensitive help about available options in this section.

Note: Consider the benefits of creating a workflow that would send the JDF files from this create 
imposition process template to an output from imposition process step. This would allow  Prinergy 
Evo to automatically impose files, and then output the imposition to proof.
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3. In the Process Start dialog box, you can select and drag files to change the 
order. When you have arranged the PDF digital master files in the desired run 
list order, click Go.

In the Process Start dialog box, you can change which process template 
Prinergy Evo will use to process your files. In addition, you can dynamically 
change settings in the process template, and you can select a different Preps 
template or signature layout.

4. Monitor processing in Process Viewer. When the process is finished, locate 
your completed files. 

Prinergy Evo creates a populated JDF imposition file in the location you 
specified in Processed File Preferences area of the process template. The 
system also creates a new folder, JDFMarksFlats. This folder contains the 
marks specified on the Preps template selected in the create imposition 
process template. 

Note: Prinergy Evo automatic imposition creates only JDF files. Other imposition file formats are not 
supported.
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Output FromImposition and Check in Prinergy Virtual Proofing System 
software

1. Confirm that your Prinergy Evo system has an output from imposition process 
template configured to output to Prinergy Virtual Proofing System software. 
The default process template is OutputImposition-VPS-Factory.

2. Select the populated EvoITP_Fat.p0001_impo.jdf file and 
EvoITP_Fat.p0001_impo.pdf marks file created by Prinergy Evo. 

3. Submit the JDF file to the OutputImposition-VPS-Factory imposition 
template using your preferred method:

– If you submit via a hot folder, you must submit the JDF file and marks PDF 
file at the same time from the same location. 

– If you submit via a template palette or the Template Browser, submit the 
JDF file only. The marks PDF file must reside in the same location as the 
JDF file.

4. Monitor processing in Process Viewer. When the process is finished, locate 
your completed files.

5. Locate and open the Prinergy Virtual Proofing System software files.

6. In Prinergy Virtual Proofing System software, you can see the imposition 
marks, trim boxes, and sheet marks specified in the Preps template you 
selected in your create imposition process template.

Activity Summary
You should now be able to write here or discuss responses to the following: 

1. Where should you store Preps templates, printer definitions, and marks in 
order to make them available to Prinergy Evo?

Write here the location where you will store these Preps files in your own 
working environment:

_________________________________________________________

_________________________________________________________

2. What imposition settings can be adjusted in a Prinergy Evo create imposition 
process template?

_________________________________________________________

_________________________________________________________

3. What will you have to do to make your own Preps templates suitable for use 
with Prinergy Evo?

_________________________________________________________

_________________________________________________________

_________________________________________________________

_________________________________________________________
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4. What settings can be adjusted in a create imposition process template when 
you submit files to Prinergy Evo ?

_________________________________________________________

_________________________________________________________

_________________________________________________________

5. Which of the jobs in your production environment are suitable for automatic 
imposition with Prinergy Evo?

_________________________________________________________

_________________________________________________________

_________________________________________________________

_________________________________________________________
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Personal Notes
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Create a Signature Booklet Proof

Who Should Complete This Activity
Prinergy Evo users

Recommended Reading
• Prinergy Evo Client Help: Output From Imposition Layout Options

Time to Complete This Activity
Approximately 15 minutes
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Create a Signature Booklet Proof

What You’ll Learn

• How to apply Signature Booklet options in the Layout section of an output 
from imposition process template 

• How to check imposition by creating a proof mock-up of the book

What You’ll Need

For this practice activity, you must: 

• Have an installed and configured Prinergy Evo system

• Locate an output-ready imposition file—for example, 
EvoITP_Fat.p0001_impo.jdf, created in Activity 28
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In this activity, you will create a process template suitable for proofing an 
imposition as a reader-order, folded booklet. You will adjust the Signature Booklet 
settings in the output from imposition process template in order to produce a 
reader-order mock-up of the imposition file you created in the previous activity.

The Signature Booklet settings provide instructions to Prinergy Evo so that when 
you submit a supported imposition file (JDF or PJTF) for processing, the system 
prints construction proofs that verify the actual assembly of signatures into the 
final product. The proofs are printed on black and white or color laser printers and 
do not require folding down and cutting plotter sheets. A proof of this type allows 
you to proof page order, content, and trim and bleed effects.

You can also output to Prinergy Virtual Proofing System software files or PDF to 
view each proof on screen. 

Configure Output From Imposition Process Template for Signature 
Booklet Proof

1. Start Prinergy Evo process template Editor.

2. Create a new output from imposition process template and save it in an 
Output from Imposition process template group (if you do not have an 
output from imposition group then create one). Assign the process template 
a new name that will identify its use for digital blueline output.

3. In the new process template, in the Output To list, select the appropriate 
output format for your print device. For more information about connecting 
print devices, refer to the Prinergy Evo Installation Guide (731-00182B).

If you do not have a printer available, select Virtual Proof in the Output To list. 

4. Expand the Layout section of the process template.

5. In the Media area, select options to suit your print device. If possible, select 
the following options for this activity:

a. In the Size list, select Cut Sheet

b. In the Max Height area and Max Width areas, type the dimensions of the 
paper you use in your proofing device. Use a larger paper size than the 
trim size of your page, so you will be able to see the imposition 
information associated with each page (crop marks, page marks, bleeds). 
If possible, use one of the following paper sizes: 

– US tabloid: 17-inch height, 11-inch width 

– A3: 420-mm height, 297-mm width 

c. Only if your output device supports duplexing, in the Duplex list, select 
Turn. 

Activity: Apply What You Know
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Do not change duplex offset settings for this activity. You may use the 
Shift Along settings in this area to adjust for imprecise duplexing on your 
printer. You will have to perform tests to determine how much to shift the 
image in order to achieve optimal duplex backup. 

6. In the Placement area, select the following options to place each page in the 
center of the available proofing media:

a. In the Orientation list, select the check box adjacent to the  icon.

b. Select Align Horizontally Center and Align Vertically Center.

7. In the Scaling area, clear all settings. These settings may be suitable for some 
proofing output, but are not suitable for this activity.

8. In the Marks area, select the following options to determine what data (in 
addition to trim page content) will appear on the proof.

a. Beside Draw Trim and Bleed Marks, select Outside Content. 

b. Leave the Sheet Marks box blank.

c. Next to Page Marks, browse to the following default page mark that is 
installed with Prinergy Evo: [PgyEvoConfig]\MarkSets\Page 
Marks\B&W Proofers\Composite Proofs\PageMark-BW-Comp.pdf.

d. In the Locate Page Marks Adjacent to list, select Bottom.

e. Beside at Distance of, type 0.5 inches or 10 mm.

f. Beside Locate Crop Mark of Length, type 0.25 inch or 3 mm.

g. Beside at a Distance of, type 0.125 inch or 1.5 mm. 

9. In the Signature Booklet area, select the following options to determine how 
your digital blueline proof will print:

a.  Select Enable Signature Booklet.

b. In the Type list, select 1up. This will print one page per sheet.

c. Do not change duplex offset settings for this activity. 

10. Expand the Processed File Preference area. 

11. If you will output this proof via a print device, select Send Processed Files to 
and type the device path.

If you will output this proof to Prinergy Virtual Proofing System software, 
select Send Processed Files to Default Location.

12. Save and close the output from imposition process template.

Click for more information from context-sensitive help about available options in this section.
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Submit a File for Signature Booklet Proof

1. Locate an output-ready imposition file—for example, 
EvoITP_Fat.p0001_impo.jdf, created in Activity 28. 

2. Submit the imposition file to your new output from imposition process 
template.

3. Monitor processing in Process Viewer. When the process is finished, locate 
your completed proof.

– If you sent the proof to a hard copy printer, collect the reader-order pages.

– If you sent the proof to Prinergy Virtual Proofing System software, locate 
and open the files—for example, EvoITP_Fat.p0001_impo.1A.1.VPS.

4. Inspect your proof. Check that:

– You can see crop marks correctly indicating the trim size. If not, check 
your settings in the Signature Booklet section of the Layout section in the 
output from imposition process template you created in the previous 
procedure.

– Pages are correctly backed up in reader order. If not, you will have to 
change your imposition template in Preps, or change the run list order in 
Prinergy Evo. You will have to create a new imposition file and submit it to 
the output from imposition process template again.

– Crop marks for each pair of backed up pages are correctly backed up. If 
not, adjust Duplex Offsets settings in the Signature Booklet area of the 
Layout section in your new output from imposition process template. 
These settings allow you to shift the pages only during proofing, without 
affecting the imposition. If you are concerned about an inaccurate match 
between the front and back of your imposition proof, check in Prinergy 
Virtual Proofing System software.   

– Page marks print correctly. 

– Page content is accurate.
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Activity Summary
You should now be able to write here or discuss responses to the following: 

1. In your own working environment, which jobs or types of work are you likely 
to output to a digital blueline proof?

_________________________________________________________

_________________________________________________________

2. What are the benefits of a digital blueline proof like the one created in this 
activity?

_________________________________________________________

_________________________________________________________

3. What are the limitations of a digital blueline proof like the one created in this 
activity?

_________________________________________________________

_________________________________________________________
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Personal Notes
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Create a Multi-process Hot Folder

Who Should Complete This Activity
Prinergy Evo users

Recommended Reading
• Prinergy Evo Client Help: Creating a New Multi-process Hot Folder

• Prinergy Evo Client Help: Assign process templates Options

• Prinergy Evo Web-based training topic:

– Standard Workflows—Imposition Options

Time to Complete This Activity
Approximately 25 minutes
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Create a Multi-process Hot Folder

What You’ll Learn

• How to configure multi-purpose hot folders

• How to use Prinergy Evo multi-purpose hot folders to create an automated 
workflow for simultaneous Prinergy Virtual Proofing System software and 
hard copy proof

• How to specify for a Prinergy Evo hot folder which files the associated process 
template should process 

What You’ll Need

For this practice activity, you must: 

• Have an installed and configured Prinergy Evo system

• Be able to configure and use a hot folder in Prinergy Evo working environment

• Have prepared an output from imposition process template like the one you 
created in Activity 29: Create a Signature Booklet Proof on page 173 of this guide

• Locate an output-ready imposition file—for example, 
EvoITP_Fat.p0001_impo.jdf, created in Activity 29. You will submit an 
imposition file as the input to the new hot folder you create in this activity.

• Locate sample PDF digital master files. You will use these files to experiment 
with how hot folders handle different file formats.

– You may use the \ITP\PreRefinedPages\ EvoITP_Fat.p0001.pdf through 
EvoITP_Fat.p0016.pdf supplied on your Prinergy Evo Training DVD.

– You may use the PDF layout flats created in Activity 27: Create a Layout 
Using Output PDF Process Template Settings on page 155 of this guide. 
These files are named:

EvoITP_Fat.1A.PDF

EvoITP_Fat.1B.PDF

EvoITP_Fat.2A.PDF

EvoITP_Fat.2B.PDF
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Prinergy Evo allows you to associate more than one process template with a hot 
folder. This allows you to create a single hot folder that will direct files to several 
process templates at the same time. If you have some jobs or types of work that 
will frequently require the same, predictable outputs, this functionality may assist 
you to automate some of your processing.

Prinergy Evo hot folder functionality also offers some automated controls that 
determine which incoming files should be processed. Using options available 
when you assign a process template to a hot folder, you can now specify what file 
types should be processed by each process template. When a user submits a file 
to the hot folder, the system will check the file type criteria and process only files 
that meet those criteria. 

In this activity, you will use the multi-process hot folder functionality to create a 
hot folder which will simultaneously output both a Prinergy Virtual Proofing 
System TIFF file set and a hard copy proof for each imposition file submitted to 
the folder. You will use file types criteria to direct the system to process only 
supported imposition files and to ignore all other files. 

Create a New Multi-Process Hot Folder for Prinergy Virtual Proofing 
System software and Digital Blueline Proofs

1. From Prinergy Evo Client software, create a new hot folder on a shared file 
server volume that is available to your Prinergy Evo server computer and 
users. 

If you need help with this step, refer to Prinergy Evo Client Help: Creating a 
New Multi-Process Hot Folder.

2. Assign the hot folder a unique name that identifies its multiple purposes: 
outputting imposition files to Prinergy Virtual Proofing System software and 
to digital blueline proofs.

3. Add to the hot folder a process template for producing Prinergy Virtual 
Proofing System software proofs:

a. In the New Hot Folder dialog box, click Add to select a process template 
to associate with this hot folder. 

b. In the Assign process template dialog box, select an output from 
imposition process template that will create Prinergy Virtual Proofing 
System software output—for example, the factory default 
OutputImposition-VPS-Factory template.

c. In the Template will be used to process area, select Files Matching This 
Criteria. 

d. In the File Type list, select Imposition Files. 

Activity: Apply What You Know
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Prinergy Evo will check the file type of files submitted to the hot folder. 
Any supported imposition file will be processed via the associated 
OutputImposition-VPS-Factory process template. Prinergy Evo supports 
PJTF and JDF imposition files, so only these file types will be processed by 
this process template. 

e. Click OK. 

4. Again in the Assign Process Template dialog box, add another output from 
imposition process template to the hot folder:

a. In the New Hot Folder dialog box, click Add to select a second process 
template to associate with this hot folder. 

b. In the Assign Process Template dialog box, select an output from 
imposition process template that will create digital blueline proof 
output—for example, the process template you created in Activity 29. 

c. In the Template will be used to process area, select Files Matching This 
Criteria. 

d. In the File Type list, select Imposition Files. 

e. Click OK. 

The New Hot Folder dialog box now shows two process templates associated 
with the hot folder.

5. In the Input Files area of the New Hot Folder dialog box, select Delete Only 
when Successfully Processed. Prinergy Evo users will have to determine what 
to do with files that fail to process. 

6. Click OK in the New Hot Folder dialog box.

Prinergy Evo is now prepared to process any supported imposition file 
submitted to this hot folder. It will process these files simultaneously, via two 
output from imposition process templates. Prinergy Evo will then delete from 
the hot folder all files that it successfully processes. 

Submit Imposition File for Multiple Outputs

1. From your shared file server volume, locate the new hot folder you created in 
the previous procedure.

2. Locate an output-ready imposition file—for example, 
EvoITP_Fat.p0001_impo.jdf, created in Activity 28. 

3. Drag the imposition file (and marks file, if necessary) to your new hot folder.

4. Monitor processing in Process Viewer.

Prinergy Evo checks the type of file submitted to the hot folder. Since JDF is a 
supported imposition file type, the system submits the imposition file to both 
process templates associated with the hot folder. 

You will see messages in Process Viewer indicating the processing status of 
the file via both process templates.

5. When the process is finished, open the hot folder you used for this procedure 
and locate the file you submitted:
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– Open the folder and note that the imposition file and its associated PDF 
marks file have been deleted from the root input folder and moved to the 
Input_Success folder. If the file failed, you can find it in the Input_Error 
folder.

6. Locate your completed imposition proof output:

a. Collect the reader-order pages created according to the specifications in 
your output process template.

b. Locate and open the imposed Prinergy Virtual Proofing System software 
files. You will find these files in the \Output folder in your hot folder.

Experiment With Input File Types

Remember that when you configured your new hot folder, you set criteria for the 
process templates that allowed each to process only imposition files. In this 
procedure, experiment with what happens when you submit another file type to 
the hot folder. 

1. Locate a PDF digital master file—for example, EvoITP_Fat.1A.PDF. This is a 
PDF layout or flat you created in Activity 27 by using the Layout options in an 
output PDF process template.

If you did not complete Activity 27, locate another PDF digital master file—for 
example, \ITP\PreRefinedPages\ EvoITP_Fat.p0001.pdf on the Prinergy Evo 
Installation DVD. This is a a single PDF page.

2. Submit the PDF digital master file to the new hot folder. 

3. Monitor Process Viewer for messages. 

4. Open the hot folder on your shared file server volume, and look for the PDF 
file you submitted. 

If you are using Prinergy Evo, you should find the file in the Input_Unmatched 
folder. 

Prinergy Evo moves the file here because the file type does not match the 
criteria you specified when you created the new hot folder. Unless the file is a 
supported PJTF or JDF imposition file, Prinergy Evo hot folders do not 
recognize it as an imposition file. Because Prinergy Evo did not process the file 
via any process template, there are no messages in Process Viewer.
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Activity Summary
You should now be able to write here or discuss responses to the following: 

1. What are some benefits of multi-process hot folders that you can apply in 
your own working environment?

_________________________________________________________

_________________________________________________________

2. How can file-matching criteria be used to streamline a hot folder workflow? 

_________________________________________________________

_________________________________________________________

3. What imposition file types are permitted for use with Prinergy Evo?

_________________________________________________________

_________________________________________________________
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Create a Workflow Template and 
Submit Files to Workflows

Who Should Complete This Activity
• System administrators

• Prepress operators

Why You Should Complete This Activity

Workflow templates:

• Allow you to link process steps and control steps together to define a 
workflow.

• Provide process consistency by minimizing manual effort, reducing errors, 
and increasing efficiency.

• Increase productivity by providing an easy way to check processing status 
and track input and output files. 

Recommended Reading
• Prinergy Evo Quick Reference Card 2

Time to Complete This Activity
Approximately 30 minutes

Note: This activity consists of four parts and each part is dependent on the 
previous part. It is important that you complete them in order, but you are not 
required to complete all parts in one working session.
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Create a Workflow Template and Submit Files 
to Workflows

What You’ll Learn

• How to create a workflow template that can be used to run multiple jobs with 
different sets of input files sat the same time

• How to use a workflow template to run and monitor more than one workflow

What You’ll Need

For this practice activity, you must have: 

• An installed and configured Prinergy Evo system (version 4.0 or later), 
licensed to output from PDF

• The following task-oriented activities files on your shared volume server in 
the Activity 31 data folder (copied from the Prinergy Evo Training DVD):

– ITP_Fat.ps

– ACT_Fat.ps

– ITP_fat.p0001a.pdf
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Part A

Create a WorkflowTemplate for Standard Prinergy Evo Workflow Configurations

Part B

Run and Monitor Workflow 1 and Workflow 2 Using the Same Workflow Template

Part C

Add an Updated Page to Workflow 1

Part D

Create an Imposition (Workflow 1)

Part A

Create a Workflow Template for Standard Prinergy Evo Workflow 
Configurations

You are going to create a workflow template that requires the following steps:

• Convert an input file to PDF

• Allow the operator to do color mapping (or another task) and refine the file 
again

• Output a virtual proof from refined pages and allow the operator to approve 
them before continuing

• Create a 4-up imposition (JDF) and automatically output a virtual proof from 
the imposition file

Step 1: Convert an input file to PDF

1. In the Prinergy Evo Configure menu, select Workflow Templates. Click New.

The Workflow Template Editor displays the assembly pane on the left, the 
control steps on the upper right, and the Process Template pane on the lower 
right.

Activity: Apply What You Know

Note: You must create and save the workflow template because other tasks in this activity require it.
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2. From the Process Template pane (on the right), open the Installation Test 
Procedure folder inside Factory Templates, and drag the Refine toPDF-ITP 
process template to the assembly pane (on the left).

Prinergy Evo automatically positions the process template icon on the first 
cell.

Tip: To delete a process step, select it, and click Delete.

Step 2: Allow the operator to do color mapping, then refine again

3. From the list of Installation Test Procedure process templates, drag another 
Refine toPDF-ITP process template to the assembly pane.

The process step icon appears in the horizontal position, next to the first 
refine. The second refine will occur after the first refine.

4. To temporarily hold the files so that the operator can do color mapping, click 
the hand icon in the second refine.

The hand icon is pointed up. The second refine will not execute until the 
operator manually releases the files.

Step 3: Output a virtual proof from refined pages

5. From the list of Installation Test Procedure process templates, drag 
OutputPDF-VPS-ITP to the assembly pane.

The hand icon is pointed to the right, Prinergy Evo will automatically output 
virtual proofs after the second refine.

Step 4: Allow the operator to approve virtual proofs, and create a 4-up 
imposition (JDF)

6. From the list of Installation Test Procedure process templates, drag Impose-
4up-ITP to the assembly pane.

The process step icon appears in the vertical position, below the virtual proof 
processing step. The hand icon is pointed to the right, Prinergy Evo will create 
the imposition at the same time it outputs virtual proofs.

7. To temporarily hold the files so that the operator can approve the virtual 
proofs (and optionally adjust the run list or signature list), click the hand icon 
that controls the Impose-4up-ITP step.

The hand icon is pointed up. Prinergy Evo will not create the imposition until 
the operator manually releases the files.

Step 5: Output a virtual proof from imposition JDF file

8. From the list of Installation Test Procedure process templates, drag 
OutputImposition-VPS-ITP to the assembly pane.

The hand icon is pointed to the right, Prinergy Evo will automatically output 
virtual proofs after it creates the 4-up imposition.
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Save Your Workflow Template

9. From the File menu, click Save Workflow Template.

10. In the Save Template dialog box, click the New Group button.

11. In the New Template Group dialog box, type a name for the group that will 
contain your workflow template, and click OK.

12. In the Save as box, type a name for your workflow template.

13. Click Save.

Your workflow template is saved and added to the Template Browser.

14. Close the Workflow Template Editor.

Part B

Run and Monitor Workflow 1 and Workflow 2 Using the Same Workflow 
Template

You will process two sets of input files using the workflow template that you 
created. Prinergy Evo will process each set of input files separately, and neither 
workflow will affect the other workflow.

Run Workflow 1

15.  From the Window menu, select Template Browser, and open the group that 
contains your workflow template.

Under Type, notice that your workflow template is classified as Workflow.

16. From the Activity 31 data folder on your shared file server volume, drag 
ITP_Fat.ps to your workflow template in the Template Browser.

The Process Start dialog box appears with the name of your workflow 
template and lists the input file ITP_Fat.ps.

17. Because you will be creating more than one workflow, you should give each 
workflow a name. In the Name box, type Workflow 1.

18. Click Go.

19. To watch Prinergy Evo process your file, from the Window menu, select 
Process Viewer: View by Process.

Next, you will learn how to monitor the status of your job by your workflow.

Monitor Workflow 1

20. From the View menu, select View by Workflow.

Workflow 1 appears in the Process Viewer: View by Workflow dialog box.

21. To display the status of the workflow, click the show workflow icon.

A yellow check mark appears for several seconds, indicating that the first 
refine was successful but it contains warnings.
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The upright hand is pointed up next to the second refine process step. 
Prinergy Evo is holding eight files and will not refine them until you release the 
files.

22. Double-click any process under Workflow 1 to display the Workflow dialog 
box.

Workflow 1 appears at the top of the Workflow dialog box. 

The Workflow dialog box shows all of the workflow icons and process steps 
that belong to your workflow.

The waving hand indicates that Prinergy Evo is waiting for you to release the 
files. The two panes below show the input file and PDF files created by the 
first refine.

Release and Refine Three Files

23. Click the second refine process step.

A blue square indicates which step you selected.

The PDF files from the previous step appear in the Input Files pane of this 
step. They are ready to be released and refined again.

24. Select the first three files, and click the Release button  above the Files 

Created pane.

The Release Elements dialog box displays the files.

Remember, the workflow template is set up so that Prinergy Evo will 
automatically execute the next process step and output virtual proofs of the 
files after the second refine is complete.

Note: You can change the color mapping settings now, but you will learn about 
Prinergy Evo dynamic settings in another activity.

25. To refine the files and output virtual proofs (.vps files), click Go.

A green check mark appears for several seconds behind the virtual proofing 
process step. Prinergy Evo reports the status of the refined PDF files in the 
Files Created pane (at the lower right).

Prinergy Evo waits for you to release the files again and impose the files. You 
will do this later in this activity.

Open and View Virtual Printing Files (Prinergy Virtual Proofing System 
software)

26. Click the OutputPDF-VPS-ITP process step.

27. In the Created Files pane, select the signature at the top of the list.

28. To view the signature in the Prinergy Virtual Proofing System software, click 

the Open button  above the Input Files pane.

For more information about Prinergy Virtual Proofing System software, see 
the Prinergy Evo Help.

29. Quit the Prinergy Virtual Proofing System software.
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Refine Remaining Files and Output Prinergy Virtual Proofing System 
software

30. Make sure the Workflow dialog box shows on your screen.

A waving hand beside the second refine process step indicates that there are 
more PDF files to be released.

31. In the Workflow dialog box, select the second refine process step.

32. Select files ITP_Fat.p0004.pdf through ITP_Fat.p0008.pdf, and click 

Release .

33. Click Go.

A yellow check mark appears for several seconds, indicating that the first 
refine was successful but it contains warnings.

A green check mark over the output to Prinergy Virtual Proofing System 
software process step (OutputPDF-VPS-ITP) indicates that Prinergy Evo 
successfully created the .vps files.

34. To view the list of signature files in the Files Created pane, click the 
OutputPDF-VPS-ITP process step.

Later, you will finish processing the refined .pdf files using Workflow 1.

Run Workflow 2

You will process another input file using the same workflow template that you 
used to run Workflow 1.

35. From the Activity 31 data folder on your shared file server volume, drag ACT-
Fat.ps to your workflow template in the Template Browser.

The Process Start dialog box appears.

36. In the Name box, type Workflow 2.

37. Click Go.

Monitor Workflow 2

38. To confirm that Prinergy Evo has started Workflow 2, from the View menu, 
select Process Viewer: View by Workflow.

39. Click the show workflow icon to view the process steps in Workflow 2.

The process steps are the same as those in Workflow 1 because Prinergy Evo 
launched both workflows from the same workflow template.

40. Double-click any process step in Workflow 2 in the Process Viewer to display 
the Workflow dialog box.

Workflow 2 appears at the top of the Workflow dialog box. Prinergy Evo has 
successfully refined the files and is waiting for you to release them.

Release and Second Refine All PDF Files (Workflow 2)

41. Click the second refine process step in the Workflow dialog box.
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42. In the Input Files pane, select all .pdf files, and click Release  above the 

Files Created pane.

Note: You can change the color mapping settings now, but you will learn about 
Prinergy Evo dynamic settings in another activity.

43. To refine the files and output virtual proofs (.vps files), click Go.

Prinergy Evo processes the files, then waits for you to release the files and 
impose them. You will do this later in this activity.

Create a 4-up Imposition .JDF File and Output .VPS Files (Workflow 2)

44. Click the Impose-4up-ITP process step.

45. In the Input Files pane, select all .pdf files.

46. Click the Release button, and click Go.

Prinergy Evo creates the ACT_Fat.p0001_impo.jdf file.

47. To view the list of imposed .vps files, click the OutputImposition-VPS-ITP 
process step.

Processing by Workflow 2 is completed.

 Part C

Add an Updated Page to Workflow 1

Imagine you have received an updated page that must replace 
ITP_Fat.p0001.pdf.

To add the page you must return to Workflow 1 and process it, then resume 
processing where you left off before starting Workflow 2. 

48. To display the Workflow dialog box, from the Window menu, select Process 
Viewer: View by Workflow.

49. Double-click any process step in Workflow 1.

Notice that Prinergy Evo is still waiting for you to release and impose the 
refined .pdf files.

50. From the RefinedMasters data folder (which is located one level up from the 
Activity 31 folder) on your shared file server volume, drag ITP_Fat.p0001.pdf 
to any area in the Workflow dialog box for Workflow 1.

Prinergy Evo starts with the first workflow step when processing added files.

The Add Files to Workflow dialog box appears.

51. Click Go.

The refined ITP_Fat.p0001.new.pdf file appears in the Files Created dialog 
box.

Re-refine the Added File (Workflow 1)

52. Select the second refine processing step.
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Note: You can change the color mapping settings now, but you will learn about 
Prinergy Evo dynamic settings in another activity.

53. In the Input Files pane, select ITP_Fat.p0001.new.pdf, and click Release.

A green check mark over the output to Prinergy Virtual Proofing System 
software process step (OutputPDF-VPS-ITP) indicates that Prinergy Evo 
successfully created the .vps files.

54. To confirm the signatures, click the OutputPDF-VPS-ITP processing step and 
open any signature in the Files Created pane.

Part D

Create an Imposition (Workflow 1)

55. Click the Impose-4up-ITP processing step.

56. In the Input Files pane, select all of the files except ITP_Fat.p0001.new.pdf.

57. Click OK.

The animated cog behind the Impose-4up-ITP processing step indicates that 
Prinergy Evo is processing the files. A green check mark confirms the 
imposition (JDF) file and virtual proof were created successfully.

58. Select the Impose-4up-ITP processing step.

 Notice that the ITP_Fat.p0001.new.new_impo.jdf appears in the Files 
Created pane.

59. To view the imposed virtual proof in the Files Created pane, click the 
OutputImposition-VPS-ITP processing step.

60. Open any signature and click Open .

Processing for Workflow 1 is completed.
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Activity Summary
You should be able to write here or discuss responses to the following:

1. With Prinergy Evo you can submit and process files using a template palette, 
the Template Browser, and now workflow templates. What advantage do 
workflow templates have over the other methods?

_________________________________________________________

_________________________________________________________

2. Which method do you think provides the most control and is least prone to 
manual errors?

_________________________________________________________

_________________________________________________________

3. Do you plan to use workflow templates, template palettes, or the Template 
Browser?

_________________________________________________________

_________________________________________________________
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Use Dynamic Settings to Reduce the 
Number of Process Templates

Who Should Complete This Activity
• Prepress operators

• System administrators

Why You Should Complete This Activity
Dynamic settings allow you to make process template settings changes on the 
fly before the process is executed. This gives you the flexibility to make 
processing decisions without the need to create a new process template.

Recommended Reading
• Prinergy Evo Release Notes

• Prinergy Evo Client Help: Refine to PDF Options

• Prinergy Evo Client Help: Output from PDF Options

• Prinergy Evo Client Help: Output from Imposition Options

Time to Complete This Activity
Approximately 15 minutes



Module 32: Use Dynamic Settings to Reduce the Number of Process Templates

202  Activities Guide

Use Dynamic Settings to Reduce the Number 
of Process Templates

What You’ll Learn

How making last-minute, temporary changes can reduce the total number of 
templates you need and increase your productivity.

What You’ll Need

For this practice activity, you must have: 

• An installed and configured Prinergy Evo system (version 3.0 or later)

• The following task-oriented activities files on your shared volume server in 
the Activity 32 data folder (copied from the Prinergy Evo Training DVD):

– ITP_fat.p0001.pdf

– ITP-4up.pjtf 
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To avoid creating multiple nearly identical process templates, Prinergy Evo allows 
you to make last minute changes to frequently used settings before processing, 
such as screening settings.

For this activity you will explore the temporary process template settings for:

– Refine to PDF

– Output from PDF

– Output from Imposition

You will make changes to process templates but processing is not required.

Dynamic Settings for Refine to PDF Process Templates

You will make some temporary changes to color, spot color mapping, and factory 
color library settings.

1. From the Window menu, select Template Browser.

2. Expand the Refine to PDF - Factory process group.

3. Drag ITP_fat.p0001.pdf from the Activity 32 data folder to the RefineToPDF 
process template in the Template Browser.

The Settings button in the Process Start dialog box allows you to make last-
minute changes to the process template.

4. Click Settings.

The Process Template Settings dialog box appears. It contains all the settings 
you can change.

Change the Color Settings (RefineToPDF Process Template)

5. To display the color settings, click Color in the left column.

6. Ensure that the Enable spot color handling is selected.

This allows you to define spot colors or other spot color mapping parameters. 
For more information, see the Prinergy Evo Help.

7. In the Spot color mapping area (near the bottom of the dialog box), select 
Secondary-Green.

8. In the Action box, select Convert to Process.

This setting appears in the Action column, opposite Secondary-Green.

Activity: Apply What You Know

Note: These changes are temporary and do not modify the underlying process template.
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9. In the Spot color recipes area, select Lookup color in database.

Prinergy Evo looks in the Prinergy Evo color database for the color recipe of 
the colors defined in the input file.

10. In the Factory box, select PANTONE LAB 1999.

Optional: Change Other Settings (RefineToPDF Process Template)

11. You can change the OPI settings, Font settings, Overprint settings, and 
Output settings. For information on each setting, see the Prinergy Evo Help.

Cancel Your Changes to the RefineToPDF Process Template

Normally you would process the input file, and after processing, Prinergy Evo 
would abandon the temporary changes to the process template.

12. Click Cancel.

13. Close the Process Start dialog box.

Dynamic Settings for Output From Process Templates

You will make some temporary changes to the calibration settings and screening 
settings.

14. In the Template Browser, expand the Installation Test Procedure process 
group.

15. Drag ITP_fat.p0001.pdf from the Activity 32 data folder to the OutputPDF-
VPS-ITP process template in the Template Browser.

16. To display the Process Template Settings dialog box, click Settings.

Change Calibration Settings (OutputPDF-VPS-ITP Process Template)

17. To display the calibration settings, click Calibration in the left column.

18. Ensure Per-job calibration is selected.

This applies the same curve or curve set to all separations in the process.

19. In the Harmony curve box, select HP2500-coated CMYK Staccato35 600.

Prinergy Evo will apply this curve to the output.

20. Select Per-color calibration.

Allows you to set a specific curve to each separation in the process.

21. In the Color column, select Secondary-Green.

The Kodak Harmony® tonal calibration software curve for this color appears 
in the Harmony curve box.

22. In the Harmony curve box, select Epson7500.glossy CMYK Staccato35 720.

23. In the Color column, select Magenta.

24. In the Harmony curve box, select Epson5000.coated CMYK Staccato35 720.
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Change the Screening Settings (OutputPDF-VPS-ITP Process Template)

25. In the Screening area, in the Dot shape box, select Round-Square(Euclidean).

26. In the Angles area, select Custom, and select Secondary-Green.

This allows you to change the screen angle for the selected color.

27. In the Angle box below, select 105.

Optional: Change Other Settings (OutputPDF-VPS-ITP Process Template)

28. You can change the Output settings and Color settings. For more information 
on each setting, see the Prinergy Evo Help.

Cancel Your Changes to the OutputPDF-VPS-ITP Process Template

Normally you would process the input file, and after processing, Prinergy Evo 
would abandon the temporary changes to the process template.

29. Click Cancel.

30. Close the Process Start dialog box.

Dynamic Settings for Output From Imposition Process Templates

A Preps PJTF imposition file is available for output. You will make some temporary 
changes to the color settings for the front surface of the signature.

31. From the Window menu, select Template Browser.

32. Expand the Installation Test Procedure process group.

33. Drag ITP-4up.pjtf from the Activity 32 data folder to the OuputImposition-
VPS-ITP process template in the Template Browser.

The Process Start dialog box appears. It lists the ITP-4up.pjtf file and the 
colored icons which indicate that the imposition consists of eight separations.

34. Click the + box to expand ITP-4up.pjtf to display Signature 1.

35. Expand Signature 1.

The Front surface consists of eight separations, and the Back surface consists 
of only six separations.

The check marks on the left indicate that Prinergy Evo will apply any changes 
you make to the signature or surface.

Change the Colors (OuputImposition-VPS-ITP Process Template)

36. Ensure that the Front surface check box is selected, then select the Front 
surface.

37. To display the Color Mapping dialog box, click Color.

The Action for spot color Creo Cyan is Leave untouched.

You will map Creo Cyan to a process color.

38. Select Creo Cyan.

39. In the Action drop-down list, select cyan
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Cyan appears in the Action box and in the Action column above, opposite 
Creo Cyan.

40. Click OK.

Compare the Color Processing (OuputImposition-VPS-ITP Process 
Template)

41. In the Process Start dialog box, select the Back surface.

42. Click Colors to display the Color Mapping dialog box.

The Action for spot color Creo Cyan is Do not output. Prinergy Evo will not 
output this color during processing.

As you can see, mapping colors on the front surface does not affect color 
mapping on the back surface of the signature.

43. Click OK.

Optional: Change the Other Settings (OuputImposition-VPS-ITP Process 
Template)

44. To change other settings, in the Process Start dialog box, click Settings.

45. You can change the Colors settings, Calibration settings, Screening settings, 
and Output settings. For information, see the Prinergy Evo Help.

Cancel Your Changes to the OuputImposition-VPS-ITP Process Template

Normally you would process the input file, and after processing, Prinergy Evo 
would abandon the temporary changes to the process template.

46. Click Cancel.

47. Close the Process Start dialog box.
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Activity Summary
You should be able to write here or discuss responses to the following:

1. Do dynamic settings modify the underlying process template?

_________________________________________________________

_________________________________________________________

2. What are the advantages of using dynamic settings?

_________________________________________________________

_________________________________________________________

3. Which dynamic settings do you expect to use more often than other dynamic 
settings?

_________________________________________________________

_________________________________________________________
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Use Dynamic Settings to Build a 
Signature List for Create Imposition

Who Should Complete This Activity
• Prepress operators

• System administrators

Why You Should Complete This Activity
Dynamic settings allow you to select multiple signatures to create a multiple 
signature imposition.

Recommended Reading
• Prinergy Evo Release Notes

• Prinergy Evo Client Help: About Creating Imposition Plans in Prinergy Evo

• Prinergy Evo Client Help: Output from Imposition Options

• Preps 5.0 User Guide (731-00002A-Rev A)

Time to Complete This Activity
Approximately 15 minutes
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Use Dynamic Settings to Build a Signature List 
for Create Imposition

What You’ll Learn

How to use dynamic settings to select multiple signatures to create a multiple 
signature imposition

What You’ll Need

For this practice activity, you must have: 

• An installed and configured Prinergy Evo system (version 3.0 or later), 
licensed to automatically create imposition files

• The following task-oriented activities files on your shared volume server in 
the Activity 33 data folder (copied from the Prinergy Evo Training DVD):

– CreateImpo.tpl

– 36pgAuction_Evo.pdf
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You have a 36-page document that has been previously refined. For finishing you 
must use dynamic settings to create the following list of custom list of signatures:

• Signature 1:  8-page work & turn

• Signature 2:  8-page work & turn

• Signature 3:  4-page work & turn

• Signature 4:  16-sheetwise

Prinergy Evo will create a populated imposition JDF file using the Create 
Imposition feature which uses Preps templates.

More specifically, you will:

• Copy the Preps template to the folder where Prinergy Evo looks for Preps 
templates.

• Apply dynamic settings to an existing create imposition process template to 
build a signature list for creating impositions.

• Output virtual proofs from the imposition JDF and check the signatures.

Copy the Preps Template to Prinergy Evo Preps Folders

You must identify the location of Prinergy Evo’s Prep Folders, and copy the Preps 
template to the appropriate folder.

1. In the Process Viewer, from the System menu, select Preps Folders.

2. In the Preps Folders dialog box, note the location of Templates and Marks, 
and close the dialog box.

3. Browse to the CreateImpo.tpl Preps template in the Activity 33 data folder 
and copy it to the Prinergy Evo Templates and Marks folder.

Create an Imposition by Applying Dynamic Settings to an Existing Create 
Imposition Process Template

You will use a create imposition process template that is supplied with the 
Installation Test Procedure for Prinergy Evo. 

Submit the PDF Input File Using the Template Browser

4. From the Window menu, select Template Browser.

5. Expand the Installation Test Procedure process group.

6. Drag 36pgAuction_Evo.pdf from the Activity 33 data folder to the Impose-
4up-ITP process template in the Template Browser.

The Process Start dialog box appears and lists the 36pgAuction_Evo.pdf file.

Activity: Apply What You Know
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7. In the Job box, type the name of the job, such as Activity 33.

Apply Dynamic Settings to the Impose-4up-ITP Create Process Template

8. In the Process Start dialog box, click the Settings button.

The Process Template Settings dialog box appears.

9. In the Imposition Planning area, select Custom.

Custom allows you to build the signature list. Prinergy Evo will choose the 
signatures for you if Auto select is selected.

10. From the Binding style list, select Saddle stitched.

The type of binding that you select determines which Preps templates you 
can select in the Templates list.

11. In the Templates list, expand the list of signatures for the CreateImpo 
template.

Prinergy Evo displays the 16-page Sheetwise signature, the 8-page Work & 
Turn signature, and the 4-page Work & Turn signature.

To accommodate all 36 pages of the job, finishing requires four signatures in 
the following order:

– Signature 1:  8-page work & turn

– Signature 2:  8-page work & turn

– Signature 3:  4-page work & turn

– Signature 4:  16-page sheetwise

12. To build the signature list:

– Select Evo 8pp Work & Turn, and click the Add button.

Prinergy Evo adds signature 1 to the list area below and displays a page 
number (for example, 1), which is the first page of the run list to which the 
signature is applied.

– Again, select Evo 8pp Work & Turn, and click the Add button.

The page number is 9, which is the ninth page of the run list to which 
signature 2 is applied.

– Select Evo 4pp Work & Turn, and click the Add button.

– Select Evo 16pp Sheetwise, and click the Add button.

The signature run list for all 36 pages is completed.

13. Click OK.
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Create a Populated Imposition JDF File

14. To create the JDF file, click GO in the Process Start dialog box.

Prinergy Evo puts the JDF file in the Impositions folder, which is in the same 
folder as the first input file (or in the folder specified in the process template).

Prinergy Evo also creates a new folder called JDFMarksFlats. This folder 
contains the marks specified on the Preps template that is selected in the 
create imposition process template.

Submit the JDF File to Output From the Imposition Process Template

You will use an output from imposition process template that is supplied with the 
Installation Test Procedure for Prinergy Evo. 

15. If necessary, from the Window menu, select Template Browser.

16. Expand the Installation Test Procedure process group.

17. Drag 36pgAuction_Evo.jdf from the Imposition folder to the 
OutputImposition-VPS-ITP process template in the Template Browser.

The Process Start dialog box appears and lists the 36pgAuction_Evo.jdf file.

18. In the Job box, type the name of the job, such as Activity 33.

Apply Dynamic Settings to OutputImposition-VPS-ITP Output From the 
Imposition Process Template

You will specify the file delivery location for the virtual proof .vps files.

19. In the Process Start dialog box, click the Settings button.

The Process Template Settings dialog box appears.

20. Select Output in left-hand column

21. Select Send processed files here, and type .\VPS

Prinergy Evo will automatically output the Prinergy Virtual Proofing System 
software .vps files to the VPS folder, which is located in the same folder as the 
first input file. If the VPS folder does not exist, Prinergy Evo will create it.

22. Click OK, and click Go.

Monitor the Process in the Process Viewer

23. From the Window menu, select Process Viewer: View by Process.

Prinergy Evo processes the JDF file and outputs the .vps files.

View .VPS Files

24. Start the Prinergy Virtual Proofing System software.

25. In the VPS folder (in the Activity 33 data folder) on which you saved the 
output files, open all of the .vps files in the Prinergy Virtual Proofing System 
software.
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In the Prinergy Virtual Proofing System software, you can select each 
signature and check the front-to-back alignment and backup.

For information about the Prinergy Virtual Proofing System software, see the 
Prinergy Evo Help.

Activity Summary
You should be able to write here or discuss responses to the following:

1. What are the advantages of using dynamic settings rather than Autoselect to 
build the signature list?

_________________________________________________________

_________________________________________________________
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Output a Single PostScript Flat

Who Should Complete This Activity
• Prepress operators

• System administrators

Why You Should Complete This Activity
Ouput a single PostScript flat and save time without refining to PDF first.

Recommended Reading
• Prinergy Evo Release Notes

• Prinergy Evo Client Help: Output from PostScript process template

Time to Complete This Activity
Approximately 10 minutes
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Output a Single PostScript Flat

What You’ll Learn

How to configure an output process plan to output a single PostScript flat without 
refining to PDF first

What You’ll Need

For this practice activity, you must have: 

• An installed and configured Prinergy Evo system (version 3.0 or later)

• A license for Output from Postscript

• The following task-oriented activities file on your shared volume server in the 
Activity 34 data folder (copied from the Prinergy Evo Training DVD):

– ReportPage.ps
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You will create an output from PostScript process template to create a virtual 
proof, and configure the ouput device, file delivery location, media, and layout 
placement. You will then input a press-ready PostScript file and output a 
PostScript flat to the Prinergy Virtual Proofing System software.

Create an Output from PostScript Process Template

1. Start the Prinergy Evo Process Template Editor.

2. In the Process Template Editor, from the File menu, select New Output from 
PostScript Template.

Configure the Output Device

3. In the new process template, in the Output To list, select Virtual Proof.

Configure the Processed File Location

4. Expand the File Delivery area of the process template.

5. In the Processed File Location area, select Send Processed Files to, then type:  
.\VPS.

Prinergy Evo will automatically output the virtual printing .vps files to the VPS 
folder, which is located in the same folder as the first input file. If the VPS 
folder does not exist, Prinergy Evo will create it.

Define the Media

6. Expand the Layout area of the process template.

7. In the Size area, select Cut sheet.

8. In the Max Width box, type 25 (inches).

9. In the Max Height box, type 20 (inches).

Configure the Layout Placement

10. In the Layout area, in the Placement area, select Center Horizontally.

This centers the layout along the horizontal axis of the media.

11. In the [Shift] Along Height, type 1 (inch).

This shifts the layout from the bottom edge of the media along the vertical 
axis.

Activity: Apply What You Know
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Optional: Configure Other Settings

You can optionally configure other settings for the output from Postscript process 
template. For example, Prinergy Evo can create Print Production Format (PPF) 
files and ink reports.

The output PostScript process template does not allow you to color manage. 

Save Your Process Template

12. From the File menu, select Save.

13. In the Name box, type OutputPostScript-VPS.

14. Click Create Process Template.

Submit the PostScript Input File Using the Template Browser

15. From the Window menu, select Template Browser.

The  icon beside OutputPostScript-VPS indicates that this process 
template will process PostScript files.

16. Drag ReportPage.ps from the Activity 34 data folder to the 
OutputPostScript-VPS process template in the Template Browser.

17. In the Process Start dialog box, in the Job box, type the name of the job, such 
as Activity 34.

18. Click Go.

Monitor the Process in the Process Viewer

19. From the Window menu, select Process Viewer: View by Process.

Prinergy Evo processes the PostScript file and outputs the .vps files.

View the .VPS Files

20. Start the Prinergy Virtual Proofing System software.

21. In the VPS folder where you saved your output files, open all of the .vps files 
that you want to preview in the Prinergy Virtual Proofing System software.

For information about the Prinergy Virtual Proofing System software, see the 
Prinergy Evo Help.



Output a Single PostScript Flat

Prinergy Evo    221

Activity Summary
1. PostScript files must be refined in order to output PostScript flats, pages, and 

separations directly. True or False?

_________________________________________________________

_________________________________________________________

2. The Output from PostScript process template does not allow you to color 
manage. True or False?

_________________________________________________________

_________________________________________________________
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Remake a Plate Using Plate ID

Who Should Complete This Activity
• Prepress operators

Why You Should Complete This Activity
Remake plates in less time and increase productivity.

Recommended Reading
• Prinergy Evo Release Notes

• Prinergy Evo Client Help: Remaking Elements

• Prinergy Evo Client Help: Remaking a Plate, Film, or Proof

Time to Complete This Activity
Approximately 10 minutes
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Remake a Plate Using Plate ID

What You’ll Learn

• How to create a process template that can remake a plate using the plate ID

• How to submit an input file, enter a plate ID, and remake a plate

What You’ll Need

For this practice activity, you must have: 

• An installed and configured Prinergy Evo system (version 3.0 or later)

• A license for Process Remake

• The following task-oriented activities file on your shared volume server in the 
Activity 35 data folder (copied from the Prinergy Evo Training DVD):

– Activity35.pjtf (includes a plate ID)
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Normally, you must locate the file that you want to remake and resubmit it for 
processing. Now you can enter the Plate ID and Prinergy Evo will automatically 
find the matching file and process it using the same process settings.

For this activity you will:

• Create an output from imposition process template that allows process 
remakes and outputs virtual proofs.

• Submit an imposition PJTF file to the process template.

• Confirm the Plate ID in the imposed proof in Prinergy Virtual Proofing System 
software.

• Resubmit a separation and remake the file using the Plate ID and reconfirm in 
Prinergy Virtual Proofing System software.

Create an Output From Imposition Process Template

The new process template will be based on the existing OutputImposition-VPS-
Factory process template.

1. From the Configure menu, select Process Templates.

2. Expand the Factory Templates\Output from Imposition process group.

3. Double-click the Output from Imposition-VPS-Factory process template.

Virtual Proof is the default setting in the Output To box. This process 
template is configured to output to Prinergy Virtual Proofing System software.

Configure the Device to Enable Remakes

4. Expand the Device area of the process template.

5. Select the Copy Input Files and Enable Process Remake check box.

Configure the Processed File Location

6. Expand the File Delivery area of the process template.

7. In the Processed File Location area, select Send Processed Files to, and type  
.\VPS

Prinergy Evo will automatically output the Prinergy Virtual Proofing System 
software .vps files to the VPS folder, which is located in the same folder as the 
first input file. If the VPS folder does not exist, Prinergy Evo will create it.

Save Your Process Template

8. From the File menu, select Save As.

Activity: Apply What You Know
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9. Locate the Process Templates folder (up two levels). In the Name box, type 
OutputImposition-VPS-Remake.

10. Click Create Process Template.

Submit the Imposition PJTF File to the OutputImposition-VPS-Remake 
Process Template

11. From the Window menu, select Template Browser.

12. Drag Activity35.pjtf from the Activity 35 data folder to the 
OutputImposition-VPS-Remake process template in the Template Browser.

13. In the Process Start dialog box, in the Job box, type the name of the job such 
as Activity 35.

14. Click Go.

Monitor the Process in the Process Viewer

15. From the Window menu, select Process Viewer: View by Process.

Prinergy Evo processes the Activity35.pjtf file and outputs .vps files.

View .VPS File

16. Start the Prinergy Virtual Proofing System software.

17. In the VPS folder where you saved the output files, open the black separation 
file, such as Activ.Activity35.1A.K.vps.

Plate ID 0000-013C appears beside Signature 1. Note that a unique plate ID 
is generated each time. The plate ID is of the form ####-####.

For information about the Prinergy Virtual Proofing System software, see the 
Prinergy Evo Help.

Prepare to Remake the Separation

18. To avoid confusion with the new output, delete all .vps files in the VPS folder 
for Activity 35.

Remake the Separation

19. From the Edit menu, select Remake Separation by ID.

The Remake by Separation ID dialog appears.

20. In the Enter Separation ID box, type 0000-013C.

21. Click Remake.

Monitor the Process in the Process Viewer

22. From the Window menu, select Process Viewer: View by Process.

Prinergy Evo processes the Activity35.pjtf file, remakes the black separation, 
and outputs the .vps file.
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View the Remake of Black Separation

23. If necessary, start the Virtual Proofing System software.

24. In the VPS folder where you saved your output files, open the black 
separation file Activ.Activity35.1A.K.vps.

Confirm Plate ID 0000-013C on Signature 1.

For information about the Prinergy Virtual Proofing System software, see the 
Prinergy Evo Help.

Activity Summary
1. Which section of the Output from Imposition process template contains the 

setting Copy Input Files and Enable Process Remake?

_________________________________________________________

_________________________________________________________

2. Plate ID is dynamic and changes each time the file is output. True or False?

_________________________________________________________

_________________________________________________________

3. Remake Separation by ID is available from which menu?

_________________________________________________________

_________________________________________________________
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Use TIFF Downloader to Output  1-bit 
Prescreened (Halftone) TIFF Files

Who Should Complete This Activity
• Prepress operators

• System administrators

Why You Should Complete This Activity
The New Output from TIFF Template allows you to output 1-bit TIFF files.

Recommended Reading
• Prinergy Evo Release Notes

• Prinergy Evo Client Help: What is an Output from TIFF process template?

• Prinergy Evo Client Help: Output from TIFF process template Options

• Prinergy Evo Client Help: Processing 1-Bit TIFF Files Directly to Plate or Spectrum

Time to Complete This Activity
Approximately 10 minutes
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Use TIFF Downloader to Output  1-bit 
Prescreened (Halftone) TIFF Files

What You’ll Learn

How to configure an Output from TIFF process template to output 1-bit 
prescreened (halftone) TIFF files from 1-bit prescreened TIFF input files

What You’ll Need

For this practice activity, you must have: 

• An installed and configured Prinergy Evo system (version 3.0 or later)

• A license for Output From TIFF

• Task-Oriented Activities 1-bit .TIF files on your shared volume server in the 
Activity 36 data folder (copied from the Prinergy Evo Training DVD)
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Given a prescreened 1-bit TIFF file, you want to output a 1-bit prescreened 
(halftone) TIFF file and image it directly on plate.

For this activity you will:

– Create an Output from TIFF process group.

– Create and configure a New Output from TIFF process template that 
outputs 1-bit prescreened (halftone) TIFF files and outputs virtual proofs.

– Submit prescreened 1-bit TIFF files to the Output from TIFF process 
template.

– Confirm the output in Prinergy Virtual Proofing System software.

Create an Output From TIFF Process Template Group

1. From the Configure menu, click Launch Process Template Editor.

2. Select Process Templates.

The new process template group will go in this folder.

3. From the File menu, select New Process Template Group.

4. In the New Group box, type Output from TIFF.

Create a New Output From TIFF Process Template

5. Select the Output from TIFF process template group.

6. From the Process Template Editor menu, select the File menu, and select 
New Output from TIFF Template.

The Output from TIFF dialog box appears.

7. In the Output To box, select Virtual Proof.

Prinergy Evo will output .vps files to the file location specified in the Output 
File Delivery area (see step 12).

8. Expand the Layout area.

9. In the Placement area, select Center Horizontally.

Activity: Apply What You Know

Note: Because it may not be possible to output to plate, you will output to the Prinergy Virtual 
Proofing System software.
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Optional:  Compensate for Press Distortion

The Scaling section of the Layout area includes the licensed Use Web Grow 
Profile, if Available feature. Web growth compensates for press distortion, 
and several web growth profiles are located in the PrinergyEvoConfig folder.

For information, see the Prinergy Evo Help Tell Me More About Web Growth 
topic.

10. Close the Layout area.

Optional: Create Ink Key Files for the Job

PrintLink is a licensed feature that creates a report of the area of ink coverage 
and the percentage of the plate covered. The information is more accurate 
than scanning; makeready is faster and there is less waste.

Ink report .ppf files can be generated without printing to plate.

For information, see the Prinergy Evo Help Tell Me More About PrintLink topic.

Warning: If PrintLink is not licensed on your system, do not select the PrintLink 
check box. If you do, you will experience technical problems during 
processing.

Configure the Processed File Location for .VPS Files

11. Expand the File Delivery area of the process template.

12. In the Processed Files Location area, select the Send Processed Files to check 
box.

13. In the Device Path box, type .\VPS.

Prinergy Evo will automatically output the Prinergy Virtual Proofing System 
software .vps files to the VPS folder, which is located in the same folder as the 
first input file. If the VPS folder does not exist, Prinergy Evo will create it.

Save Your Process Template

14. From the File menu, select Save.

15. In the Name box, type OutputFromTIFF-VPS.

16. Click Create Process Template.

Prinergy Evo stores the process template in the Output from TIFF process 
group.

17. Close the Process Template Editor.

Submit TIFF Files to the OutputFromTIFF-VPS Process Template

18. From the Window menu, select Template Browser.

19. Expand the Output from TIFF process group.

20. Drag all Print '05 .tif files from the Activity 36 data folder to the 
OutputFromTIFF-VPS process template in the Template Browser.
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21. In the Process Start dialog box, in the Job box, type the name of the job, such 
as Activity 36.

22. Click Go.

Monitor the Process in the Process Viewer

23. From the Window menu, select Process Viewer: View by Process.

Prinergy Evo processes the .tif files and outputs .vps files.

View .VPS Files

24. Start the Prinergy Virtual Proofing System software.

25. In the VPS folder (in the Activity 36 data folder) where you saved the output 
files, open all of the .vps files in the Prinergy Virtual Proofing System software.

For information about the Prinergy Virtual Proofing System software, see the 
Prinergy Evo Help.
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Transparency Handling in Refine

Who Should Complete This Activity
• Prepress operators

• System administrators

Why You Should Complete This Activity
This activity introduces you to new controls for handling PDF 1.4+ features in 
Prinergy Evo 4.0. Prinergy Evo 4.0 allows the processing of PDF files without the 
requirement that PDF files be flattened. This activity shows how to configure a 
refine process template to preserve PDF 1.4+ features such as transparency and 
layers.

Refine process templates can be configured to flatten PDF files or to preserve 
PDF 1.4+ features.

Recommended Reading
• Prinergy Evo Help: About Transparency Support in Prinergy Evo

• www.adobe.com: Transparency in Adobe Applications: A Print Production Guide

Time to Complete This Activity
Approximately 10 minutes
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Transparency Handling in Refine

What You’ll Learn

You will learn how to configure a refine process template to preserve PDF 1.4+ 
features such as transparency and layers. You will see how not flattening affects 
the Refined PDF Master file.

What You’ll Do

1. Submit a file with transparency to a stock factory process template set to 
flatten.

2. View the refined page in Acrobat with Overprint Preview disabled.

3. Modify the stock refine PT from step 1 so that it does not flatten PDF 1.4+.

4. View the refine page in Acrobat with Overprint Preview disabled to see the 
difference.

What You’ll Need

For this practice activity, you must:

• Open the shared JobData volume on the Prinergy Evo Server

• Open the Task Oriented Activities\Activity 37 folder

• Locate DropShadowSpotFile.pdf
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Important: Complete Preparing for Task Oriented Activities on page 1 of this guide prior to 
completing any activities. This describes how to copy all activity practice files to your system.
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Modify the factory process template to flatten PDF 1.4 or higher:

1. Start the Prinergy Evo Client and connect to your server.

2. Start the Process Template Editor: in the Prinergy Evo Client, select Configure.

3. Open the Refine to PDF - Factory process template from the Factory Process 
Templates -> Refine to PDF group.  

4. Expand the Normalize pane of the process template.

5. Under PDF Level Handling, set PDF 1.4 - 1.6 (Acrobat 7) to Flatten to PDF 1.3

6. Select File >Save As to save the process template with a new name in a 
location outside the Factory process templates group.

7. Close the process template.

Submit the transparency file to the process template you created:

1. Locate the unrefined DropShadowSpotFile.pdf in the Task Oriented 
Activities\Activity 37 folder within your JobData share.

2. Open the Template Browser, and locate the process template you created.

3. Drag DropShadowSpotFile.pdf to the new process template to open the 
Process Start window. 

4. Click the Settings button and select Output.

5. Set the output path in Output to .\Flattened\.

6. Click OK to apply your settings change.

7. Click Go to begin processing.

View the flattened Refined PDF Master in Acrobat

1. Locate the Flattened folder and double-click DropShadowSpotFile.pdf to 
open it in Acrobat.

2. Under the Advanced menu in Acrobat disable Overprint Preview.

3. Examine the area around the drop shadow that appears over the spot color at 
the bottom of the layout. A white box should be visible around the drop 
shadow. This is due the drop shadow being converted to non-transparent 
raster during the flattening process.

4. In Acrobat, close the PDF.

Activity: Apply What You Know
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Submit the transparency file to the factory Refine process template

1. In Template Browser, open the Refine to PDF group within the Factory process 
templates group so you can see Refine to PDF - Factory.

2. locate DropShadowSpotFile.pdf in the Task Oriented Activities\Activity 37 
folder within your JobData share (that is, the original non-flattened file).

3. Drag DropShadowSpotFile.pdf to Refine to PDF - Factory. The Process Start 
window opens. 

4. Click the Settings button and select Output.

5. Set the output path in File Delivery to .\As-is\

6. Click OK and then click Go.

View the Unflattened Refined PDF Master in Acrobat:

1. locate the \As-is folder and open DropShadowSpotFile.pdf in Acrobat.

2. Under the Advanced menu in Acrobat disable Overprint Preview.

3. Examine the area around the drop shadow that appears over the spot color at 
the bottom of the layout. In contrast to the flattened version you will not see a 
white box around the drop shadow with Overprint Preview disabled. This is 
because the transparent objects were preserved and not converted to raster.

4. In Acrobat, close the PDF.

Activity Summary
You created a refine process template that preserved PDF 1.4+ features and you 
observed how it affected Refined PDF Masters.
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Transparency Handling with 
Trapping

Who Should Complete This Activity
• Prepress operators working with systems licensed for Trapping

• System administrators working with systems licensed for Trapping

Why You Should Complete This Activity
Prinergy Evo 4.0 allows the processing of PDF files without the requirement that 
PDF files be flattened. This activity shows how to configure a refine process 
template to preserve PDF 1.4+ features such as transparency and focuses on the 
implications of preserving transparency with respect to trapping.

Recommended Reading
• Prinergy Evo Help: About Transparency Support in Prinergy Evo

• www.adobe.com: Transparency in Adobe Applications: A Print Production Guide

Time to Complete This Activity
Approximately 15 minutes
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Transparency Handling with Trapping

What You’ll Learn

You will learn how to configure a refine process template to preserve PDF 1.4+ 
features and how not flattening affects the traps within the Refined PDF Master 
file.

What You’ll Do

1. Submit a file containing transparency to two process templates, both of which 
are set to trap. One process template will flatten (that is, will remove 
transparency) and one will not flatten (that is, will preserve transparency).

2. View the resulting trapped PDF Master files in Acrobat.

What You’ll Need

For this practice activity, you must:

• Open the shared JobData volume on the Prinergy Evo Server

• Open the Task Oriented Activities\Activity 38 folder

• Locate the Annual Report.pdf file
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Important: Complete Preparing for Task Oriented Activities on page 1 of this guide prior to 
completing any activities. This describes how to copy all activity practice files to your system.
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Create two process templates to show the effect of transparency handling 
on trapping:

1. Start the Prinergy Evo Client and connect to the Prinergy Evo server.

2. Start the Process Template Editor from the Prinergy Evo Client.

3. Locate the process template Refine to PDF - Factory from the Factory Process 
Templates -> Refine to PDF group. Double-click it.

4. Expand the Normalize pane and set PDF Level Handling to Flatten to PDF 
1.3" Contract the Normalize pane.

5. Select the Trapping check box. 

6. In the File Delivery pane, set an output location of .\TrapFlat\.

7. Save the modified process template with a new name (for example, Refine-
TrapFlatten). Keep the process template open; you will edit it to make the 
second process template.

8. Expand the Normalize pane and set PDF Level Handling -> PDF 1.4 - 1.6 
(Acrobat 7) to Leave as is.

9. Under the File Delivery pane set an output location of .\TrapAsIs\.

10. Save the modified process template with a new name (for example, Refine-
TrapPreserve).  

11. Close the process template.

Submit a transparency file to both process templates and view the 
differences in Acrobat:

1. Open the Template Browser in the Prinergy Evo Client.

2. Locate Annual Report.pdf in Task Oriented Activities\Activity 38 folder in 
your JobData share.

3. Drag Annual Report.pdf to the first process template and click Go.

4. Drag Annual Report.pdf to the second process template and click Go.

5. Open the two refined PDFs from the .\TrapFlat\ and .\TrapAsIs\ folders.

6. Start the TrapViewer or TrapEditor plug-in in Acrobat (depending on what is 
licensed on your server) and compare the traps between the two PDFs. You 
should see in the TrapAsIs file that traps appear between the vertical color 
fields, while in the TrapFlat file the vertical color fields are not trapped.

Activity: Apply What You Know
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Activity Summary
You saw how flattening vs. preserving transparency affected the way pages were 
trapped.

Personal Notes
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Import and Export Templates

Who Should Complete This Activity
• System administrators

• Prepress operators

Why You Should Complete This Activity
Knowing how to import and export templates will enable you to back up and 
maintain templates without stopping Prinergy Evo. The import and export 
functions described in this chapter do not offer as comprehensive a backup 
solution as the Save/Restore Configuration procedure, but they help to ensure 
that comparable Evo systems may perform the same operations. Support 
personnel may require process and workflow templates to reproduce or 
duplicate operating conditions. Understanding how to export process templates 
while Prinergy Evo is running could expedite support assistance.

Recommended Reading
• Prinergy Evo Client Help: Export process templates, Importing process templates

• Prinergy Evo Administrator Help: Exporting Multiple Process and Workflow 
Templates, Importing Multiple Process and Workflow Templates.

Time to Complete This Activity
Approximately 30 minutes
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Import and Export Templates

What You’ll Learn

You will learn how to import and export process templates and workflow 
templates using Prinergy Evo Administrator and the Process Template Editor.

What You’ll Do

1. Use Prinergy Evo Administrator to import process templates and workflow 
templates. 

2. Use the Process Template Editor and the Prinergy Evo Client to examine 
templates. Use the Process Template Editor to export, then import, process 
templates. 

3. Examine process templates and workflow templates using Windows.

4. Use Prinergy Evo Administrator to export process and workflow templates.

What You’ll Need

For this activity, you must:

• Open the shared JobData volume on the Prinergy Evo Server.

• Locate the Task Oriented Activities\Activity 39 folder.

• Copy the Task Oriented Activities\Activity 39 folder to a location within the 
JobData volume on the Prinergy Evo server.
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Import templates using Prinergy Administrator:

1. On the Prinergy Evo server, start Prinergy Evo Administrator.

2. Click the Tools tab.

3. Click Manage Templates.

4. Select Import process and workflow templates and click Next.

5. In the Import Prinergy Evo Templates window, click the Browse button.

6. Locate the Activity 39 folder and click OK.

7. Click Import Now.

8. A warning message appears: 

The templates imported may not be usable because some of 
the dependent components such as Color Definitions, ICC and 
Preflight Profiles may not exist on the Prinergy Evo 
server. In addition, existing templates with conflicting 
names will be replaced. It is recommended to perform a full 
configuration backup and restore the image. Do you want to 
continue?

This warning advises you that process templates may depend on or refer to 
other files: the Export/Import function neither exports these dependent files 
nor imports them. Only the Save / Restore procedure both saves and restores 
these extra files and dependencies. If you import process templates that are 
missing dependent components and you open those process templates with 
Process Template Editor (PTED), a warning message will advise you about the 
missing components. 

9. Click the Yes button and import the templates. Importing templates may take 
a few minutes.

10. When you see the Templates were imported successfully message, 
click OK.

Examine the imported templates in Prinergy Evo, export them and import 
them using the Process Template Editor, then examine them in Windows:

Examine the templates from within Prinergy Evo

1. Open the Prinergy Evo Client and select Configure > Process Templates. The 
Process Template Editor opens.

2. Open the Activity 39 template group to examine its subgroups.

3. Open a few of the subgroups to see the templates within.

4. Switch focus to the Process Viewer window. Select Configure > Workflow 
Templates.

Activity: Apply What You Know
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5. Within the Configure Workflow Templates dialog box, open the Activity 39 
group and expand the Workflows sub-group to view the imported templates. 
Close the Configure Workflow Templates dialog box.

Export the templates using the Process Template Editor:

1. Switch focus back to the Process Template Editor and select the Activity 39 
template group.

2. From the File menu, select Export Process Template(s). 

3. In the Select Export Location dialog box:

a. Locate where you would like to temporarily store your templates.

b. Click New Folder and name it Activity 39 Export, then click OK.

c. Click your new folder then click Select.

4. In the dialog box that opens, click OK.

Import process templates using the Process Template Editor:

1. In the Process Template Editor, select the Activity 39 template group.

2. From the File menu, select Delete.

3. In the dialog box that opens, confirm that you want to Delete.

4. Select the Process Template Group (the top level of all process template 
groups) and then select File > New Process Template Group. Name the new 
group Imported.

5. Click the Imported group to indicate that is where you want to import the 
templates.

6. From the File menu, select Import Process Template(s).

7. In the dialog box that opens, locate the Activity 39 Export folder. Using that 
same dialog box, go inside the Activity 39 Export folder. Select the icons 
representing all of the templates and groups within the Activity 39 Export 
folder, then click Select.

8. Click the button labeled Import into group Imported. Importing may take a 
minute.

9. In the dialog box informing you that the import was successful, click OK.

10. Open the Imported group and the Imposing group within Imported to verify 
that your templates were imported. (Note: some of the process templates 
have dependencies that will cause warning dialogs to appear if those 
templates are opened in PTED. This is expected behavior).

11. Change focus to the Prinergy Evo Client. Using the Configure menu item, 
select Workflow Templates and expand the Imported group to verify that the 
Workflow templates were successfully imported.

Examine the exported templates in Windows or Mac OS:
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1. Use Windows Explorer or the Mac OS X Finder to browse to the location in 
the JobData share that contains the Activity 39 Export folder.

2. Note that, in the folders contained within, the names of the folders 
correspond to the names of the groups containing process templates and 
workflow templates. Process templates and workflow templates are fairly 
small files, suitable for compressing and sending via e-mail. 

Export templates using Prinergy Evo Administrator

In this exercise you will export all process templates and workflow templates to 
some location using the Prinergy Evo Administrator.

1. Change focus to Prinergy Evo Administrator. Make sure that Prinergy Evo is 
running.

2. Click the Tools tab.

3. Click the Manage Templates button.

4. Select Export process and workflow templates and click Next.

5. In the Export Prinergy Evo Templates window, click Browse.

6. Locate where you want to save your templates and click OK.

7. Click Export Now.

8. When the Templates were exported successfully message appear, 
click OK.

Activity Summary
You are now able to:

• Import templates using Prinergy Evo Administrator.

• Export all or selected templates or template groups using Prinergy Evo 
Process Template Editor.

• Import selected templates or template groups using Prinergy Evo Process 
Template Editor.

• Export all templates using Prinergy Evo Administrator.
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Personal Notes
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Applying Plate and Print Calibration 
Curves

Who Should Complete This Activity
• System administrators

• Prepress operators who specify calibration curves for output

Why You Should Complete This Activity
In Prinergy Evo, calibration refers to the process of modifying the size of halftone 
dots to ensure that output has the intended tonal response. There are a number 
of reasons why you might choose to calibrate output.

• Offset printing introduces dot gain. Depending on paper stock, press 
conditions, and other factors, the size of halftone dots on plate must be 
reduced to allow for that fact that they will expand on the printed piece. The 
print curve is used to provide this functionality.

• Some output devices (for example, the Kodak Magnus™ 800 with Fiber 
Head platesetter) are inherently nonlinear and output must be adjusted, so 
that halftone dots produced on the plate are the size that was intended (for 
example, 50% in a desktop application is 50% on the plate) over the entire 
tonal range. The plate curve is used to make this adjustment, if required.

• Some high-energy plates are nonlinear and require adjustment to ensure 
that halftone dots on the plate are the size that was intended. The plate 
curve is used to make this adjustment. If you use multiple device types (for 
example, Quantum and Fiber Head) and multiple plate types, then you may 
require multiple plate curves.

Calibration is a complex subject and a full description is beyond the scope of this 
activity. Consult the Harmony User Guide for a detailed description of how to set 
up calibration curves for a Prinergy Evo workflow.
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Recommended Reading
• Prinergy Evo Release Notes

• Prinergy Evo Client Help: Output from Imposition: Calibration and Screening

• Prinergy Evo Client Help: Plate curves, print curves

• Virtual Proofing System Help: Densitometer Tool

• Harmony User Guide

Time to Complete This Activity
Approximately 30 minutes
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Applying Plate and Press Calibration Curves

What You’ll Learn

The activity files provided for this exercise demonstrate five different 
combinations of plate curves and print curves. While other combinations are 
possible, the combinations chosen demonstrate the interaction between the two 
types of curves. For example, press marks may be calibrated independently from 
page content, they may be calibrated with the same curve that calibrates page 
content, or both press marks and page content may be calibrated with print 
curves and page curves multiplied together.

What You’ll Do

You will run a job through a Prinergy Evo workflow and produce five sets of Virtual 
Proofing System files. You will then use the Virtual Proofing System Densitometer 
tool to see how calibration curves have been applied to output. In order to have a 
consistent and easily measured target, this job will use the Kodak Plate Control 
Strip (KPCS) both as page content and as a mark.

1. Placed Page Content - The KPCS was placed in a run list in Preps as if it were a 
page to be printed.

2. Evo Sheet Mark - The KPCS was placed in Prinergy Evo using the Sheet Mark 
option in an Output from Imposition process template.

3. Evo Page Mark - The KPCS was placed in Prinergy Evo using the Page Mark 
option in an Output from Imposition process template.
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4. No Workflow Calibration - The KPCS was placed in a Preps template as a 
Smart Mark and flagged to not have workflow calibration applied to it.

5. Workflow Calibration - The KPCS was placed in a Preps template as a Smart 
Mark and flagged in Preps to have workflow calibration applied to it.

In this exercise, it is important to be able to determine whether the plate and print 
curves have been applied correctly. The job uses two curves that make it easy to 
distinguish which curve or curves have been applied to each control strip. Each of 
these curves is a linear cutback curve where every output value is multiplied by 
the same value. This is not intended to represent real-world plate or print curves.

This image represents the Harmony curve named Plotter Proof 80%. It cuts back 
every tint to 80% of its nominal value. The red line represents a nominal 50% tint.  
The green line illustrates that it will be output at 40% (0.80 x 0.50). This curve is 
used as the print curve in the exercise job. The plate curve used is a linear cutback 
to 60% of the nominal value. In that case, 50% will be output as 30% (0.60 x 
0.50).

Prinergy Evo applies the two curves by multiplying them together. For example, if 
you apply both of the above curves to a nominal 50% output, it will actually be 
output as 24% (0.60 x 0.80 x 0.50). In the exercise, you will find that the 50% 
swatches on the control strip output at 50%, 40%, 30% or 24% depending on 
the combination of curves applied in the particular example and which curves are 
applied to that specific control strip.
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To determine the actual output values, you will use the Densitometer tool in 
Kodak Virtual Proofing System 3.0 (or later).

The Densitometer tool looks like an eyedropper in the toolbar. You will use it to 
select the area you want to measure as shown by the yellow square above. If you 
include parts of multiple swatches, the Densitometer tool will calculate the 
overall tint within the selection.  

For this exercise, be sure that your entire selection is inside the upper 50% 
swatch on each control strip. The descriptions in the exercise tell you what values 
to expect for the 50% tint patch on each control strip.

What You’ll Need

For this practice activity, you must:

• Have Prinergy Evo 4.0 or later installed on your server.

• Copy the Activity 40 folder to the JobData folder on your Prinergy Evo server.

• Import the Activity 40 process and workflow templates from the DVD to 
your Prinergy Evo system (see Activity 39).

• Copy the folder Kodak Plate Control Strip from the Activity 40 Support 
folder into the folder MarkSets within the PgyEvoConfig share on your 
Prinergy Evo system.

• Install into Harmony the calibration curves within the Linear Cut Back Plotter 
Proofs.hmy database, found in the \Activity 40 Support\Harmony Curves 
folder, then restart Prinergy Evo or the Printer JTP. (For instruction on 
importing Harmony curves into Harmony, see the Harmony User Guide.) 

• Have Virtual Proofing System 3.0 or later installed on the Evo Client 
computer.
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Run the Job and Produce Virtual Proofing System Files

This job uses a workflow template to run the same input file through five different 
process templates. Five folders will be created, with each folder containing a set 
of Virtual Proofing System files with different calibration settings.

1. Open the Prinergy Evo Client.

2. Open the Template Browser window.

3. Open the Activity 40 template group.

4. Open a Windows Explorer window and locate the [JobData]\Activity 
40\Originals folder.

5. Drag the Activity 40.pjtf file from Windows Explorer to the Activity 40 WT 
template in the Template Browser window.

6. In the Process Start window that opens, click GO.

7. This job will start one workflow in View by Workflow and five processes in 
View by Process in the Process Viewer. Wait for these to complete. Processes 
should complete in about two minutes.

8. In Windows Explorer, you should now see five folders created by the job.  
These contain the Virtual Proofing System files you will use for the rest of the 
activity.

View the Effect of Calibration Using Virtual Proofing System

The folders containing the Virtual Proofing System files will be found one level up 
from the folder Originals which contained the input file. In each of the folders 
created by the job, you will find four Virtual Proofing System files. For each of the 
folders, analyze the files:

1. Open the folder and select all the .vps files.

2. Open the files in Virtual Proofing System 3.0 (or later).

3. In Virtual Proofing System, select the Densitometer tool.

4. Scroll and zoom to each control strip in turn so that you can see the 50% area 
clearly.

5. Use the Densitometer tool to draw a square completely enclosed in the upper 
50% swatch of the control strip. (See illustration above.)

6. For each swatch, compare the value you read with the Densitometer against 
the expected values in the tables below. See What You’ll Do on page 253 for 
an explanation of control strip numbering.

Activity: Apply What You Know
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Activity 40-A-None_None

This output has neither a plate curve nor a print curve applied. All output should 
be nominal.

Activity 40-B-None_80

This output has no plate curve and the 80% print curve applied. The imposition 
content should be calibrated. The Evo Sheet and Page marks are set to calibrate.  
One Preps mark should be uncalibrated as described above.

Activity 40-C-60_None

This output has the 60% plate curve and no print curve applied. All output should 
be cut back to 60% of nominal value. Since a Plate curve compensates for 
nonlinearity in the CTP device or the plate material, it is applied to all output 
regardless of other settings.

Activity 40-D-60_80

This output has the 60% plate curve and the 80% print curve applied. All output 
should be cut back to 60% of nominal value by the plate curve. Then a further 
cutback should be applied by the print curve to all output except the Preps mark 
set to have no calibration applied.

control strip 1 2 3 4 5

expected value 50% 50% 50% 50% 50%

measured value __ % __ % __ % __ % __ %

control strip 1 2 3 4 5

expected value 40% 40% 40% 50% 40%

measured value __ % __ % __ % __ % __ %

control strip 1 2 3 4 5

expected value 30% 30% 30% 30% 30%

measured value __ % __ % __ % __ % __ %

control strip 1 2 3 4 5

expected value 24% 24% 24% 30% 24%

measured value __ % __ % __ % __ % __ %
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Activity 40-E-60_80_NoMarks

This output has the 60% plate curve and the 80% print curve applied. This 
output is the same as above except that the Prinergy Evo sheet and page marks 
have been set to not calibrate. The plate curve should be applied to all output but 
the print curve should be applied only to page content and to the Preps mark set 
to allow calibration. calibrated Preps mark.

Activity Summary
You should now be able to:

• Apply plate curves to compensate for nonlinearity in output devices and 
media.

• Apply an appropriate print curve to compensate for dot gain on press.

• Control the application of the print curve to selected marks types in a job.

control strip 1 2 3 4 5

expected value 24% 30% 30% 30% 24%

measured value __ % __ % __ % __ % __ %
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Personal Notes
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Adding a Variable Text Slugline to 
Output

Who Should Complete This Activity
• System administrators

• Prepress operators

Why You Should Complete This Activity
A variable text slugline allows you to:

• Add identifier text to the plate outside the press sheet area, when using a 
"press sheet size" imposition.

• Add information to the plate that was not available when the TIFF was 
generated, when outputting a 1-bit TIFF file to plate.

Recommended Reading
• Prinergy Evo 4.0 Release Notes

• Prinergy Evo Client Help: Slugline Mark

• Prinergy Evo Client Help: Output from TIFF: Layout Options (also Output from 
Imposition: Layout Options, and Output from PDF: Layout Options)

• Prinergy Evo Client Help: Tell Me More About Variable Marks

Time to Complete This Activity
Approximately 15–30 minutes
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Adding a Variable Text Slugline to Output

What You’ll Learn

• How to create a slugline to specify static and variable information on output

• How to position a slugline on output

What You’ll Need

For this activity, you must:

• Have licenses for the Output and TIFF Downloading options on your Prinergy 
Evo system

• Have copied the Activity 41 folder to the Prinergy Evo JobData folder

• Have Prinergy VPS software installed on the Prinergy Evo client computer
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Add a Slugline To an Output From Imposition Process Template:

The JDF that you will use has been imposed to the size of the press sheet on 
which it will be printed. It already contains marks to be printed on the actual press 
sheet. The objective of this step is to add a plate identifier slugline to the plate. 
The slugline will appear in the bottom bend of the plate, outside the area of the 
actual press sheet.

The slugline will identify the job, signature, side, and color of the 1-bit TIFF files 
being output. You will also show the date and time that the plate is made, but you 
cannot add it at this point since date and time would be interpreted to show when 
the TIFF file was made, rather than when the plate is made.

1. Open the Prinergy Evo Process Template Editor and select a process template 
group, or create a group (for example, create a group and call it Activity 41). 
You will create an Output from Imposition template inside this group.

2. From the File menu, select New Output from Imposition Template.

3. At the top of the process template, in the Output To list, select Virtual Proof.

Prinergy VPS files are 1-bit TIFF files. They can be output to plate by Prinergy 
Evo TIFF Downloader and viewed on screen using Prinergy VPS software.

4. Open the Layout section and make the follow settings:

a. Media

The press sheet is 26 by 20 inches but you will create a TIFF file to output 
it on a 28-by-24-inch plate.  

- Size = Cut Sheet

- Max Width = 28 inch

- Max Height = 24 inch

b. Placement

You need to center the press sheet across the plate and shift it up 3/8 
inch to allow for the plate bend.

- Align Horizontally = Center

- Align Vertically = Bottom

- Shift Vertically = 0.375 inch

Activity: Apply What You Know

Note: If you were not adding a slugline at this point, you could make the TIFF 26 x 20 to 
allow the plate size to be determined at output time.
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c. Slugline

You will add text in the plate bend to show the job name (as represented 
by the name of the JDF file), signature, side, and color of the individual 
plate. Variables that you enter inside $[…] will be replaced with the 
appropriate information each time this process template is run. Anything 
else you enter in the slugline mark will appear on the output as you typed 
it.

- Slugline mark = 

Job: $[JobName]  Sig: $[Sig]   Side: $[SurfaceName]   
Color: $[Color]

- Text size = 10 .0

- Place on media

0.5 inch from left

0.25 inch from bottom

5. Open the File Delivery section and make the following changes:

a. Custom File Naming

- Use Custom File Naming = selected

- Filename Template = remove %job%. from the default string shown, 
leaving 
%imposition%%signature%%surface%.%color%.%extension%

b. Processed File Location

- Send Processed files to = selected

- Device Path = ..\TIFF Files

6. Save the template in your selected group and give it an appropriate name, 
such as Slugline-CreateTIFF.

Process a JDF To Create TIFF Files:

In this section, you generate TIFF files that will be used to make plates. The files 
will have a  .vps extension, but they are TIFF files and will output properly through 
Prinergy Evo TIFF Downloader. If you were going to make real plates, you would 
change the resolution to 2400 or 2540 dpi, depending on your output device. For 
this exercise, the files will come out at the default of 300 dpi.

1. In the Prinergy Evo Client software, open the Template Browser.

2. Open your Prinergy Evo job folder for this exercise and drag the .jdf file from 
\45 - Variable Text Sluglines\Activity 41\Imposed to the output from 
imposition process template that you made in the previous section in the 
Template Browser.

3. In the Process Start dialog box:

a. Type a job name such as TIFF Slugline.

b. Click Go.

4. Use the Process Viewer to determine when your process is complete.
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5. In Windows Explorer:

a. Select the \TIFF Files folder inside your Prinergy Evo job folder.

b. Select all signature 1A and 1B files, right-click, and select Open.

6. Prinergy VPS software opens and displays the TIFF files.

a. Click the Fit to Window button.

b. Zoom into the bottom-left corner of the screen to view the slugline. Verify 
that the variables have been replaced with their appropriate values for this 
job. Notice that the colors are all on top of each other on the press sheet, 
but if you turn colors off and on, you can see what the label says on each 
plate.

c. Press CTRL+F to flip the Prinergy VPS software display over to the back of 
the press sheet. Notice that the information is the same except that the 
side is now "Back".

d. Close the Prinergy VPS software window.

Add a Slugline To an Output From TIFF Process Template:

In this section, you create a process template to output the TIFF files from the 
previous section to plates and add a second slugline that shows the date and time 
that the plate was actually made and the platesetter on which it was made. You 
will simulate platemaking by outputting modified Prinergy VPS software files 
rather than actually burning plates. 

1. In the Prinergy Evo Client software, open the Process Template Editor and 
select the process template group in which you want to create your 
templates.

2. From the File menu, select New Output from TIFF Template.

3. In Output To list, select Virtual Proof.

4. Open the Layout section and select the follow settings:

a. Media

- Size = Cut Sheet

- Max Width = 28 inch

- Max Height = 24 inch
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b. Slugline

Add a slugline.

- Slugline mark = Plate burned: 
$[compound_%Date%_at_%Time%_on_CTP_%Device%]

- Text size = 10 .0

- Place on media: 

14.0 inch from left

0.25 inch from bottom

5. Open the File Delivery section and change

Filename Template to ..\PlatesOut.

6. Save the template in your selected group and give it an appropriate name 
such as Slugline-OutputPlates.

Output the TIFF Files To Plate:

In this section, you will simulate making plates from the TIFF files you made 
earlier.

1. In the Prinergy Evo Client software, open the Template Browser.

2. Open your Prinergy Evo job folder for this exercise and drag the .vps files from 
the \TIFF Files folder onto your Slugline-OutputPlates process template in 
the Template Browser.

3. In the Process Start dialog box that opens:

a. Select your job name from the Job menu if it is not already selected.

b. Click Go.

4. Use the Process Viewer to determine when your process is complete.

5. Open the Prinergy VPS software.

a. Click the Open Preview Files button.

b. Click Add.

c. Locate the \PlatesOut folder in your Prinergy Evo job folder.

d. Select all the files for the front surface of signature 1.

e. Click Open, and click OK.

6. Zoom to the lower-left corner and confirm that the original slugline is still 
present.

7. Scroll to the right to confirm that the new slugline has been added in line with 
the original slugline, and that it has been correctly translated to show date, 
time, and platesetter number.
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8. Close the Prinergy VPS software.

Activity Summary
You should now be able to:

• Add a slugline to the output from an output from imposition, output from 
TIFF, or output from PDF process template.

• Define variables for your slugline that will be replaced by Prinergy Evo when 
the process is run.

• Create Prinergy VPS software files for output by Prinergy Evo TIFF 
Downloader.

• Use Prinergy VPS software to preview plate files before outputting them to a 
platesetter.
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Personal Notes
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